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Starr Life Sciences 
Warranty Policy 

1. WARRANTY: Starr Life Sciences warrants that upon delivery the goods sold hereunder will be free of defects in
materials and workmanship, and such goods will substantially conform to the specifications furnished by the Seller, and to
any drawings or specifications furnished to the Buyer by Starr Life Sciences if approved by Starr Life Sciences.

a) Commencement of Warranty – The warranty period begins on the date of delivery. 
b) Duration of Warranty – The goods sold hereunder are warranted for a period of twelve months, except PDT-4000 and PDT-

4000HR, which are warranted for two years. 
c) Third Party Product Warranty – Third party products purchased by Buyer through Starr Life Sciences are covered by the

manufacturer’s warranty and ARE NOT COVERED BY THE Starr Life Sciences WARRANTY.
d) Place of Repair or Replacement. Buyer must return the defective or nonconforming goods upon request to Starr Life Sciences 

at Shevlin Corporate Park, Building C, 920 SW Emkay Drive, Suite 100, Bend, Oregon 97702, not later than 15 days after Starr Life 
Sciences receipt of notice of the alleged defect or nonconformance.  Buyer shall prepay transportation charges. Starr Life Sciences 
shall pay for the return of the goods to Buyer. No goods are to be returned to Starr Life Sciences without prior authorization and a 
valid service notification number.

e) Limitation of Warranty The foregoing warranty shall not apply to defects resulting from (a) improper or inadequate
maintenance by Buyer;
(b) unauthorized modification of the goods; (c) operation of the goods outside of the environmental specifications for the goods;
(d) neglect, misuse or abuse of the goods or (e) modification or integration with other goods not covered by a Starr Life
Sciences warranty when such modifica tion or integration increases the likelihood of damage to the goods.

f) Technical assistance – The warranty set forth above shall not be enlarged, diminished or affected by and no obligation or 
liability shall arise from Starr Life Sciences’s rendering of technical advice, assistance or services in connection with Buyer’s 
order of the goods furnished hereunder. The Buyer is not relying on Starr Life Sciences skill or judgment to select or furnish 
suitable goods. 

THE WARRANTY SET FORTH ABOVE IS EXCLUSIVE AND Starr Life Sciences GIVES NO OTHER WARRANTY 
WRITTEN OR VERBAL, EXPRESS OR IMPLIED. Starr Life Sciences SPECIFICALLY DISCLAIMS THE IMPLIED 
WARRANTIES OF MERCHANT ABILITY AND FITNESS FOR A PARTICULAR PURPOSE. Starr Life Science's
STANDARD WARRANTY POLICY COVERING ANY Starr Life Sciences PRODUCTS SHALL BE NULL, VOID, AND 
OF NO EFFECT IF THE BUYER OR ANY THIRD PARTY USES THAT PRODUCT FOR ANY USE OTHER THAN 
THE INTENDED USE OF THAT PRODUCT. 

2. LIMITATION OF REMEDIES AND LIABILITY. The remedies provided herein are Buyer’s sole and exclusive remedies.
Starr Life Sciences shall have no responsibility other than, at Starr Life Sciences's option, to repair or replace defective or 
nonconforming goods or to refund the purchase price of defective or nonconforming goods in the event of breach of any
warranty. IN NO EVENT SHALL Starr Life Sciences BE LIABLE FOR ANY DIRECT, INDIRECT SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES (INCLUDING LOSS OF PROFITS) WHETHER BASED ON CONTRACT, TORT OR ANY 
OTHER LEGAL THEORY. In the event that any limitation of warranty or disclaimer of liabil ity is found to be unlawful or 
inapplicable, or to have failed of its essential purpose, Starr Life Sciences liability shall be limited to the amount paid by the 
Buyer for the specific goods that caused such liability.



SOFTWARE LICENSE 

AGREEMENT

All products of Starr Life Sciences including data collection and analysis software, diskettes, CDs, and written materials 
(collectively, the “Product”) and all future orders, are subject to the terms stated below.

1. LICENSE: Starr Life Sciences grants you a personal, non-transferable, non-exclusive license to use this package upon the
terms set forth herein. The Software, including any upgrades thereof, shall remain Starr Life Science's property, subject to this
Agreement. You and your employees and agents are required to protect the confidentiality of the Software. You may not
distribute or otherwise make the Software available to any third party. The Software may be used by any number of people
and may be freely moved from one computer location to another, so long as it is not being used at more than one location at
any time. However, the Software may be used, if applicable, on a single computer for data acquisition, and on a single computer
for data analysis.

2. LIMITED WARRANTY: Starr Life Sciences warrants for a period of twelve (12) months after the date of delivery to
you (the “Warranty Period”), the following:

a. that the software will perform in substantial compliance with the Instructions Manual, provided that it is used with the data
collection hardware, computer hardware and with the operating system for which it was designed.

b. that the media on which the Software is distributed is substantially free from significant defects in b) materials and
workmanship.

3. LIMITED REMEDIES: In the event of a breach of this warranty, Starr Life Sciences sole obligation is to replace or repair,
at Starr Life Sciences option, any product or component thereof, free of charge.

Warranty claims must be made in writing during the Warranty Period and within seven (7) days of the observation of the defect, 
accompanied by evidence satisfactory to Starr Life Sciences All products should be returned to Starr Life Sciences or the Starr Life 
Sciences distributor from which they were purchased and shall be shipped by the returning party with freight and insurance paid.

EXCEPT AS STATED ABOVE, THERE IS NO WARRANTY, EXPRESSED OR IMPLIED, REGARDING THE PRODUCT INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OR MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

4. LIMITATION OF Starr Life Sciences LIABILITY: Starr Life Sciences entire liability for damages to you and any other party 
for any cause whatsoever, whether in contact or in tort, including negligence, shall not exceed the price you paid for the unit or 
Product that caused the damages or that the subject matter of, or caused by your failure to perform your obligations, or for any
loss of data, profits, savings, or any other consequential and incidental damages, even ifStarr Life Sciencesr has been advised of
the possibility of damages, or for any claims by you based on any third party claim.

TERMINATION: Your failure to comply with the terms of this Agreement shall terminate your license and this Agreement. Sections 
2, 3, and 4 shall survive any termination of this agreement.
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Thank You! .....for purchasing the VitalView Data Acquisition System from Starr Life Sciences 

If you need assistance with VitalView, remember that Starr Life Sciences support continues 
after the purchase. If you have any problems or questions, please call our Technical 
Support Staff consisting of technicians, engineers, and scientists. We are available by 
telephone, fax, e-mail, or website. 

Contacting Starr Life Sciences Technical Support 

Mailing and 
Shipping 
Address

Starr Life Sciences
333 Allegheny Ave, Suite 300
Oakmont, PA 15139
USA

Telephone (866) 978-2779
(412) 828-3932

Fax (866) 978-2779
(412) 828-3932

E-Mail technicalsupport@starrlifesciences.com
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This manual is written in the same order as you should assemble and configure your system. 
To ensure everything works properly, pay particular attention to sections 2 through 5. These 
sections will guide you through connecting the hardware, installing the software, and most 
important, properly configuring your experiment. 

• Section 1 – Introduction and Specification is an overview and specification of the
product.

• Section 2 - PC Interface Card and Software Installation will help you prepare your
computer and load VitalView into your computer.

• Section 3 – Hardware Installation tells you how to assemble your system.

• Section 4 – System Setup will assure the software will communicate with the
hardware.

• Section 5 – Animal &Group Setup is the portion of VitalView that will “customize” it
to your particular experiment, and define which data VitalView will collect.

• Section 6 – Data Collection Monitor is the heart of the actual data collection. You will
begin your experiment, and watch as the data are collected.

• Section 7 – Data Load & Analysis prepares the raw data for analysis.

• Section 8 – Appendices -Details to guide you through specific procedures.

Some products within the Starr Life Sciences VitalView system contain electronically active 
components. Examples of safety conventions follow. Please take these precautions 
seriously, and keep your project safe. 

WARNING! – A warning indicates danger of harm to yourself or your subject, and recommends 
steps to avoid the problem. 

CAUTION! – A caution indicates the danger of damage to the hardware, or loss of data, 
and recommends steps to avoid the prob lem. 

NOTE: Handy information important enough to highlight, and that may save you time and 
consternation. 

Getting 
Started

Safety
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Laboratory Practices

External VitalView electronic components are not designed to be water-resistant. Receivers 
and other electronic devices should be kept away from sources of water and high humidity, 
or wrapped in plastic to provide moisture protection. 

Animal wastes are extremely corrosive. It is therefore necessary to safeguard against 
exposing components to their effects. For small animal applications, receivers are not 
contained within the animals’s cage but underneath, providing adequate protection. For 
applications requiring the receiver to be placed in the cage, please contact Starr Life 
Sciences for additional information and precautions. 

The enclosures for the VitalView receivers should not be exposed to direct sunlight for long 
periods. A common sense approach to placement will prevent breakdown of the plastics, 
overheating of the components, skewing of temperature data, and hyperthermia of the 
subject. 

Cables and connectors can be damaged if the cables are improperly seated, or pulled 
without releasing the fastening screws or latches. Bent pins and broken conductors are a 
common cause of system failure. 

Keeping the enclosures of the receivers clean can be accomplished with a wipe of a damp 
cloth. Avoid getting water into the end connectors and inside electronics. 

Transmitters require special cleaning. Requirements for cleaning and sterilization are 
discussed fully in the “Implantation Procedure” in the appendix section. 

Shipping Requirements

These devices radiate electrical energy and may require special shipping procedures. 

Please contact us first for a Return Authorization (RA) number. This will alert us when your 
shipment arrives, and we will have procedures in place to expedite turnaround.

Please clean all equipment before returning it to Starr Life Sciences. 

For the protection and health of our staff, please sterilize all transmitters and E-Mitters
 
prior to 

returning to the factory. Sterilization procedures may be found in “Implantation Procedure” in the 
appendix section. 

Humidity and 
Moisture

Animal 
Wastes

UV and IR 
Exposure

Connectors

Cleaning

Transmitters

Other 
Devices

A VERY IMPORTANT REQUEST!!
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SECTION

INTRODUCTION AND 
SPECIFICATION

VitalView is a software and hardware system specifically designed for controlling data 
acquisition in laboratory monitoring of physiological parameters. The VitalView System 
consists of an application program known as VitalView and several types of acquisition 
hardware, including the Series 4000 transponder/ receiver systems, QA-4 activity input 
modules, DP-24 digital multiplexer, and more. 

VitalView is a system of integrated components cohesively working together as a unit. 
Depending on your research needs, you may have in your possession a variety of the 
components. This section explains the function of each product, and will introduce you to 
the versatility of VitalView. For additional illustrations on system assembly, see Appendix B, 
“Hardware Configurations.” 

This manual is organized in the same general order in which you will likely set up your 
project. This section introduces you to the components of the VitalView System. 

VitalView is a data acquisition system that integrates multiple radio telemetry technologies 
as well as switch-closure activity monitoring into one comprehensive laboratory tool. 
VitalView is comprised of two systems, each defined according to the topology used for 
physiological monitoring. Since many customers integrate both systems into a hybrid system, 
this manual includes instructions on both the Series 3000 and the Series 4000 products. 

VitalView

Hardware 
Introduction
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PCI Interface 

VitalView will support the PCI (Peripheral Component Interconnect) interface cards based 
upon the operating systems listed below: 

• Windows 7 (32 and 64 bit)
• Windows Vista (32 and 64 bit)
• Windows XP SP2 (32 bit)

The VitalView Series 3000 sytem is capable of independently monitoring up to 240 running 
wheel and motion detecting inputs. 

This system uses PDT-4000 and G2 E-Mitters to acquire animal temperature and activity 
data. The PDT-4000 and G2 HR E-Mitters acquire temperature, activity, and heart rate 
data. E-Mitters utilize a technology unique in the physiological monitoring field. These 
transponders collect data on temperature, heart rate, and gross motor activity for the of 
the animal. No batteries are required. E-Mitters obtain power from a radio frequency field 
produced by the ER-lifetime 4000 Energizer/Receiver. VitalView is capable of monitoring 32 
individually housed subjects implanted with E-Mitters.

Series 3000 
Overview

Series 4000 
Overview

System Specification 
Computing Platform 

Element Specification Condition
Computer platform Pentium 500 MHz or higher
System RAM 512 MB or higher
Hard disk drive 500 MB Minimum free space
CD Drive Required
Card bus PCI Required

Serial bus 19.2 Kbaud
One required for Series-4000 
receivers*

Display Super VGA, 256 color Minimum

Operating System
Windows 7 (32 and 64 bit), 
Vista (32 and 64 bit), and XP 
SP2 (32 bit)

Computer enclosure Standard ATX Full height required for PCI card
*Serial to USB adapter available.
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Series 4000 System 
Element Specification Condition
ER-4000 receiver size 56 cm x 29 cm x 7 cm
ER-4000 receiver weight 2.6 kg
Communications type RS-232 serial
Communications speed 19.2 Kbaud
Polling rate 1 per second
Number of receivers in chain 32 Maximum
Number of receivers per power supply 4 Maximum
Distance between ER-4000 receivers 20 cm Minimum
Averaging buffer size 2 to 256 seconds For temperature and heart rate
E-Mitter range 12 cm Minimum, at center of ER-

4000 with E-Mitter oriented 
longitudinal to receiver.

Series 3000 System 
Element Specification Condition
DP-24 dimensions 20.5 cm x 25 cm x 6.5 cm
DP-24 weight 1.8 kg
DP-24 Communications type 50-pin parallel
Polling rate 20 times per second Maximum
Number of input sockets on DP-24 6 Total
Number of receivers per DP-24 6

12

Maximum, when not using dual 
input module

Maximum, when using dual 
input module

Number of channels per DP-24 socket 4 Maximum
Number of DP-24 channels 24 Maximum
Power supply for DP-24 1 Required
TR-3000 receiver dimensions 30 cm x 22.5 cm x 3 cm
TR-3000 weight 1 kg
Distance between TR-3000 20 cm Minimum
Averaging buffer size 1 to 256 seconds For temperature
QA-4 dimensions 16 cm x 9.5 cm x 3.5 cm
QA-4 weight 197 g
QA-4 input jacks 4 Maximum
QA-4 channels per DP-24 24 Maximum, when using four-each 

QA-4 modules
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The PCI Hardware Interface Card provides communication between the computer and 
Series 3000 hardware, such as DP-24 DataPort. The PCI card is plug and play compatible 
when used with the included drivers. 

This device accumulates activity counts for each channel that is on-line. Samples are 
continuously taken or counted by the DP-24 DataPort until the PC reads them and 
clears the storage site for the next sample or count accumulation period. Because of 
this arrangement, the amount of time the PC must spend accumulating samples is greatly 
reduced. This allows the system to sample data channels very quickly, and makes possible 
independent sampling intervals for individual data channels. For more information on 
integration into the system, see the “DP-24 DataPort” section in Section 3 and Appendix B. 

The QA-4 allows four switch-closure devices to be monitored using only a single data jack on 
the DP-24 DataPort. The device has four inputs and four LEDs. Each closure activates a front 
panel LED. For installation information, see this section in Section 3 and Appendix B. 

Running wheel revolutions are monitored by the system as switch closures. The number 
of revolutions per sampling interval or “bin” is accumulated by the DP-24 DataPort and 
communicated to the PC when the sampling time is completed. 

Running wheels are typically outfitted with either a magnetic or optical switch. Both allow 
for silent monitoring to reduce the entrainment effect. Details on running wheels can be 
found in Section 3 and Appendix B. 

Motion detectors may be used with VitalView. Typically these are the types of devices 
used in security, where motion of an object within the field triggers a switch closure. They 
may be thought of as switch-type devices similar to running wheels. See Section 3 for 
more information. 

Depending on which system you have purchased, several cables may be required to complete 
a system. The Series 3000 system runs on a parallel platform; Series 4000 runs on a serial 
platform. Each cable is unique to its application, and can easily be connected properly. Following 
is a brief description of VitalView cabling. 

C-50 Cable 
The C-50 cable assembly is a 50-conductor ribbon cable required to connect the DP-24 
DataPorts to the Hardware Interface Card, or to interconnect the DP-24’s in a “daisy-chain” 
configuration. Both ends of the cable are female, and are polarized. Care must be taken to 
insure correct polarity from the Computer Interface Card to the receiver. 

Hardware Introduction
PCI Hardware 
Interface Card

DP-24 
DataPort

QA-4 Activity 
Input Modules

Running 
Wheels

Infrared 
Motion 
Detectors

Cabling
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C-50 Cable - Note red stripe to ensure correct polarity

NOTE: Maximum length of this cable from PC to the first DataPort is 50 meters. Maximum length of 
this cable between any two DataPorts is 10 meters. Care should also be exercised to keep these cables 
away from external noise sources, such as fluorescent lamps, power supplies, etc. 

C-8 Cable 
The C-8 cable assembly is an 8-conductor “telephone type” ribbon cable required for signal 
input to the DP-24 DataPort. The connectors on both ends are male, telephone-type RJ-45 
plugs. The standard length of this cable as shipped from Starr Life Sciences is 14 feet. When 
installing C-8 cables, observe the EMI precautions listed in Section 3. 

C-8 Cable. Polarity determined by connector

NOTE: This cable is wired straight through, i.e., “A to A,”  “B to B.” 

Y-Cable Connector Set 
The Y-Cable Connector Set is used to connect power and signal to an ER 4000 Energizer/
Receiver, and begin the first unit of a “daisy chain” of serial VitalView monitors. More on the 
use of this cable can be found in Section 3. 

Y-Cable Connector Set

Female D-9 serial port on PC

Male D-9 to “From Computer”
on ER-4000

D-5 to power supply
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ER Interlink Cable 
ER Interlink Cable assembly connects ER-4000 Energizer/Receivers together in serial 
combination. This cable carries the data and power from one D-9 port to the next unit. 

ER Interlink Cable

This product allows two dual-channel devices to be connected to one port of a DP-24. The 
feeding monitor is dual-channel (feeding frequency and feeding duration), and the TR-3000 
is dual channel (activity and temperature). The Dual Input Module allows all four channels 
to be connected to one port of a DP-24. Connection of this product is detailed in Section 3 
and in Appendix B. 

The TR-3000 is capable of monitoring a radio transmitter as well as switch closures. 
Temperature and gross motor activity are the two telemetric functions supported, and 
switch closure data are received via the two auxiliary inputs. 

All functions are discussed in Section 2 - Hardware Installation. Further connection details 
are in Appendix B. 

*NOTE: The TR-3000 receiver is no longer available. This manual includes information on the TR-3000 
receiver as support for customers who puchased these receivers in the past.

The ER-4000 Energizer/Receiver is capable of monitoring one PDT-4000 E-Mitter/G2 
E-Mitter, or PDT-4000HR/G2 HR heart rate E-Mitter. Thirty-two of these units may be 
placed in a single serial chain connected to the PC serial port. One ER-4 Power Supply may 
supply up to four ER 4000s. 

E-Mitters are able to capture energy from the field of radio waves generated by the coils 
of the ER-4000 Energizer/Receiver. The energy captured from the electrical field powers 
the circuitry in the E-Mitter, resulting in a return signal to the receiver. The receiver and 
E-Mitter are tuned to maximize the efficiency of this exchange. 

Depending on the E-Mitter, heart rate, temperature, and activity can be monitored. The 
E-Mitter has no battery and so may be used indefinitely. More information on selecting an 
E-Mitter can be found in Section 3. 

Dual Input 
Module

Series 3000 
Receiver*

Series 4000 
Energizer/ 
Receiver

Series 4000 
E-Mitters
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SECTION 

PC INTERFACE CARD AND 
SOFTWARE INSTALLATION 

The procedures in this manual assume that you are using the “classic start menu” view. To 
switch to the classic view, right-click on the Start button, select Properties, and click “Classic 
Start menu.” Click OK. to change the Control Panel to classic view, open the Control Panel 
(Start > Settings > Control Panel) and click “Switch to Classic View.” 

NOTE: A judicious and systematic approach to setting up the sys tem is imperative. We remind you our 
Technical Support numbers and addresses are listed in the front of this manual. 

NOTE: For instructions on how to install VitalView Series 3000 and Series 4000 hardware, see Section 3  
“Hardware Installation.” 

This section describes how to prepare your personal computer for VitalView. This includes 
adjusting operating system settings, physically installing the PCI Hardware Interface Card in 
your computer, and installing the VitalView Data Acquisition software. 

The VitalView software enables the researcher to incorporate multiple radio telemetry 
technologies in addition to activity monitoring using switch closures. Although the Series 
3000 and Series 4000 systems utilize different technologies for physiological monitoring, 
both may be used simutaneously as one cohesive system. 

We assume you have a fundamental knowledge of computers, such as Windows operation, 
and file manipulation and organization. VitalView does not require skills beyond common 
knowledge such as double-clicking, using pop-up menus, control arrows, click-and-type, etc. 
Unless you are told differently, “click” means pressing the left mouse button.

Windows XP Users

Introduction

Before You Begin - Assumptions
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 Recommended computer skills. 

It is important to configure your PC prior to installing the VitalView software. With your PC 
set up properly, VitalView will install and run at top performance. 

It is recommended that you use the following display settings when using VitalView 
software. Please see the help documentation for your operating system, or contact 
Product Support, if you need assistance making these changes. 

-Screen Saver: None 

-Font (DPI): 96 DPI/Small Fonts 

-Screen Resolution: 800 x 600 pixels or higher 
          1024 x 768 recommended

-Color Resolution: 256 colors or higher 

Daylight Savings/Standard Time Changes 
CAUTION! Unless this function is disabled, Windows will automat ically reset the PC time to reflect 
changes between standard and daylight time. This may interfere with data collection. One hour of data 
may be lost and all data time after the time change may be shifted one hour. 

Most experiments will not require data collection to span the period in which time changes 
are experienced due to daylight/standard time. However, it will be desirable to disable the 
automatic updating of the PC clock in response to daylight/standard time changes. 

Folder Name

Current File

File Extension

PC Preparation
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Windows XP 

1 From the Windows Desktop click Start > 
Settings > Contro Panel. 

2 Double-click on Date\Time. 

3 Select Time Zone tab. The following 
display will appear. 

Access: Start > Settings > Control Panel > Date/Time 

4 Uncheck Automatically adjust clock for 
daylight savings changes. 

5 Check for other real clock parameters 
such as correct time, time zone, etc. 

6 Click the OK button. 

Windows Vista 

1 From the Windows Desktop click Start > 
Control Panel. 

2 Click Classic View. 

3 Double click ‘Date and Time’. 

4 Click ‘Change Time Zone’. 

5 Uncheck ‘Automatically adjust clock for 
Daylight Saving Time’. 

6 Click ‘OK’, then click ‘OK’ again. 

Windows 7

1 From the Windows Desktop click on the 
time/date display (typically in the lower 
right corner).

2 Click ‘Change Date and Time Settings.’

3 Click ‘Change Time Zone.’

4 Uncheck ‘Automatically adjust clock for 
Daylight Saving Time.’

5 Click ‘OK’, then click ‘OK’ again. 

An Important Note 

It is important while preparing your PC for VitalView research that the above steps are 
completed, the PC clock set to the correct time, and Daylight Savings clock changes disabled. 
Once an experiment begins, be aware of the following: 

• Do not change the PC time clock once the experiment begins. 

• If your experiment spans a Daylight/Standard time change, do not reset your PC clock. 
At the beginning of the experiment, set your PC clock to whatever time you prefer, and 
leave it for the duration of the experiment. 

PC requirements are listed in Section 1. The program and associated files require 50 MB of 
disk storage space. 

Be sure your PC is properly configured as per the procedure at the beginning of this section. 

CAUTION! VitalView requires many PC resources; it is strongly recommended a dedicated system 
be used for data collection. Run ning other programs while VitalView is collecting data can result in 
irregularities in system performance, or possible loss of data. 

Installing VitalView
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Uninstalling VitalView 

Uninstalling VitalView 2.20 or earlier (Windows XP or Vista)

To properly install an upgrade, you should use the following procedure to remove any 
previous versions of VitalView. 

Use Windows Explorer to review the contents of folders with VitalView configuration and 
data files. In order to load data that has been collected with version 2.20 and earlier into 
VitalView 3.0, 3.1, or 4.0, it will be convenient to have a record of the times of the first 
and last data points from the existing VitalView files. You may also use the earlier VitalView 
version to load data to find these times. 

It is recommended all VitalView 2.20 or earlier data be kept separate from version 3.0, 3.1, 
or 4.0 data. 
1 Click the Start button, select Programs, VitalView, and click on Uninstall VitalView. 

2 Click Yes to any “Warning! Attempt to erase file with read-only attribute” messages. 

3 Wait for the “VitalView uninstalled successfully” message, and click OK. 

4 If you had VitalView set up for crash recovery, use Window Explorer to delete the 
crash.exe shortcut from the Windows > Start Menu > programs > StartUp folder. Also 
delete any desktop icon shortcuts you created. 

5 Use Windows Explorer to check if the installation folder still exists. If it does, it means 
there are configuration and data files remaining in the folder. (The VitalView installation 
files will have been removed by the uninstall program.) Rename the folder, or move 
the configuration and data files to a different folder, then delete the original installation 
folder. 

This completes the uninstall process. 

Uninstalling Version 3.0 or 4.0 (Windows XP or Vista)
1 Click on Start, select Settings, click Control Panel, and double click Add/Remove 

Programs. 

2 Select VitalView from the list box, and click the Add/Remove button. 

3 Click “Yes” to each of the “Warning! Attempt to erase file with read-only attribute” 
messages. 

4 Wait for the “VitalView uninstalled successfully” message, then click OK. 

5 Select NI LabVIEW Run-Time Engine 6.0 from the list box, and click the Add/Remove 
button. 

6 If you had VitalView set up for crash recovery, use Window Explorer to delete the crash.
exe shortcut from the Windows > Start Menu > Programs > StartUp folder. Also delete 
any desktop icon shortcuts you created for VitalView. 

7 Use Windows Explorer to check if the installation folder still exists. If it does, this means 
there are configuration and data files remaining in the folder. (The VitalView installation 
files will have been removed by the uninstall program.) Rename the folder, or move the 
configuration and data files to a different folder, then delete the original installation folder. 
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VitalView Installation - PCI Interface Card 

For Windows 7, Vista, or XP.

NOTE: Installation of the PCI Interface Card is only necessary if your system includes Series 3000 
hardware (such as DataPorts, TR 3000 Receivers, and QA-4 Input Modules). If your VitalView system will 
only be used to control Series 4000 hardware then proceed to “VitalView Installation for Series 4000 
without PCI” in Section 2. 

NOTE: Do not install the PCI Interface Card until instructed to do so. The InstaCal drivers must be 
installed prior to installing the hardware card. 

Preliminary 

1  If you are upgrading from an earlier version of VitalView already installed on your 
computer, uninstall the previous version of VitalView. Refer to “Uninstalling VitalView” 
in Section 2. 

2  The CD is set to auto run. Insert the VitalView installation CD into your drive, and 
wait for the setup menu to appear. The Main Menu includes options to: 

• Install VitalView 

• View Instruction Manual 

• Read about Actiview, a companion program to VitalView 

3 If the setup menu does not appear after a few minutes, click Start, select Run, and 
type: 

 D:\cdmenu.exe 

4  At the CD Main Menu, click on Install the VitalView Data Acquisition System Software. 

5  Click on Install VitalView for PCI Interface Card. 

6  Click on 1. Install InstaCal Driver Software and follow the instructions as prompted. 

NOTE: When asked to Choose Destination Location, you must select C:\CB or D:\CB for VitalView to 
operate properly.” 

7  If the InstaCal installation software prompts you to reboot your computer, allow it 
to do so. 

8  Once the computer has rebooted, shut down the computer completely by clicking Start 
and selecting Shut Down.

9  Once the computer has powered down completely, proceed with the installation of the 
PCI Interface Card as shown below. (These instructions can also be accessed from item 2 
in the CD setup program under “Install ViewView for PCI Interface Card.” 

PCI Hardware Interface Card Installation 

The PCI Hardware Interface Card plugs into a standard PCI expansion slot in your 
computer. Expansion slots “expand” the functionality of your computer to run VitalView. the 
PCI Hardware Interface Card expands the ability of your computer to communicate with 
Series 3000 hardware devices, such as DataPort and QA-4 Input Modules. 
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If your system will not include Series 3000 hardware, then the PCI Interface Card is 
not necessary, and you may proceed to “VitalView Installation for Series 4000 without 
PCI” in Section 2. 

The only tools you should require is a Phillips screwdriver and a static strap. 

WARNING! - Unplug the AC power cord to the computer prior to opening the case. Follow all 
applicable manufacturer’s precautions as well. 

CAUTION! - Hardware Interface cards, like most circuit boards, may be damaged by static 
discharge. Keep the card in the protective bag until you are ready to insert it. Always handle the 
card by the edges. We strongly recommend the use of the ESD (electrostatic dis charge) suppression 
strap included with your card. The strap is worn around the wrist, and the other end is attached to 
a non-painted, metallic part of the PC’s frame. It will drain static electric ity to the computer’s frame 
preventing ESD damage. Failure to take precautions may result in the destruction of the interface 
card and the computer. 

Consult the illustration which follows for a common PC tower configuration. Computer 
layouts vary, but most will be configured similarly whether desktop or tower style. 

1 Turn off the PC, unplug the power cable, and make sure you are wearing a static 
strap. Connect the lead from the static strap to the metallic frame of the computer. 

2 Remove the cover from the PC. Consult your PC owner’s manual for detailed 
information about your computer. 

3 Locate the PCI expansion slots in your computer. These slots are usually white 
connectors residing on the main circuit board of the computer. Different makes and 
models of PCs will have a differing number of available expansion slots. 

4 Select an available expansion slot. Due to the C-50 cable, the VitalView card may be 
thicker than other expansion cards. Select an expansion slot that has adequate space. 

5 Remove the metal cover from the mounting bracket that corresponds to the expansion 
slot you have chosen. This cover is typically a narrow metal band attached to the back 
panel of the PC by a single screw. Save this screw. It will be used later. 

6 Carefully remove the PCI Hardware Interface Card from the protective bag. Make sure 
to grasp it only by the edges. A short, 50-pin pigtail cable is connected to the card. It 
should not be necessary to remove this connector for installation. 
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7 Insert the free end of this cable through the mounting bracket on the Hardware 
Interface card. This cable will exit the back of the PC and connect to the C-50 cable 
allowing for communication with Series 3000 components. A drawing of this cable can 
be found in Section 1, Hardware Components. 

8 For insertion, the card must be oriented so the metal mounting bracket is directed 
toward the back frame and the tab connector is down. 

9 Grasping the card by the corners so the tab on the card that contains the bus connector 
points downward, position it over the socket. 

10 Insert the free end of the 50-pin pigtail cable through the back of the PC. 

11 Gently insert the tab into the socket and press straight down into place. 

12 The card should be level when properly placed in the socket, and the metal mounting 
bracket should be aligned for attachment to the frame with a screw. 

13 Permanently mount the card with the screw previously set aside. 

14 Replace computer cover. 

15 Proceed to software installation below. 

NOTE: The VitalView PCI Hardware Interface Card is a plug and play compatible device. When used 
in conjunction with the InstaCal drivers, this card will find and use free I/O addresses based on your 
computer’s hardware configuration 

Final PCI Interface Card Software Installation 

1  Turn the computer on. With some operating systems, you should see the Found New 
Hardware message has appeared, indicating that the PCI-DIO48H board (PCI Interface 
Card) was found. 

2  Once the operating system has loaded, reinsert the CD-ROM, or click Start, select Run, 
and type: 

 D:\cdmenu.exe 

3  At the CD Main Menu, click on Install the VitalView Data Acquisition System Software. 

4  Click on Install VitalView for PCI Interface Card. 

5  Click on 3. Run InstaCal Driver Software. The InstaCal program should run. 

6  The InstaCal program should automatically detect the new card and display a message. 
Click “OK” and select File > Exit. 

7 Click on 4. Install VitalView Software for PCI and follow the instructions as 
prompted. 

NOTE: You may be prompted to accept a license agreement from National Instruments. This is required 
to install auxiliary runtime software to allow VitalView to run.

VitalView Installation for Series 4000 without PCI 

This procedure should be used only if you are going to use Series 4000 Receivers and you 
do not intend to use Series 3000 devices, or you are installing VitalView for data analysis 
purposes. In this case the PCI Interface Card need not be installed. You need only to install 
the VitalView software. 
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1  If you are upgrading from an earlier version of VitalView already installed on 
your computer, uninstall the previous version of VitalView. Refer to “Uninstalling 
VitalView” in Section 2. 

2 The CD is designed to auto run. Insert the VitalView installation CD into your drive, and 
wait for the setup menu to appear. The Main Menu includes options to: 
•  Install VitalView 
• View Instruction Manual 
• Read about Actiview, a companion program to VitalView 

3 If the setup menu does not appear after a few minutes, click Start, select Run, and 
type: 

 D:\cdmenu.exe 

4 At the CD Main Menu, click on Install the VitalView Data Acquisition System Software. 

5  Click Install VitalView for Series 4000 Hardware and follow the instructions as 
prompted. 

NOTE: You may be prompted to accept a license agreement from National Instruments. This is required 
to install auxiliary runtime software to allow VitalView to run.

It is recommended that the PC be connected to a UPS. Although VitalView has programming 
that allows it to automatically recover its data collection configuration after a power 
interruption, a UPS provides a definite margin of security in case of power interruption. It is 
also recommended that other hardware devices be provided with a UPS as well. 

Second Installation of VitalView 

This would be an ideal time to install VitalView on a second computer. 

With VitalView running while data are being collected, a substantial amount of memory may 
be being used. If you need to analyze data on an on-going basis, you should install VitalView 
on a second computer. This will allow you to copy experiment files and perform analysis on 
one computer without running the risk of interrupting the collection of data on the other 
computer. 

NOTE: If data were collected over a fall or spring daylight savings time change, and a second installation 
of VitalView is used to load this data, this second computer also needs to be set to not automatically 
adjust its clock for daylight savings changes. 

NOTE: Although these modifications are minor, they will alter the way that the computer re-boots from a 
hard crash such as after a power failure. Following this procedure will result in the computer being able 
to login auto matically, no longer providing password security. If you do not feel comfortable making 
these changes or are unsure if they should be made, it is recommended that you seek the assistance of 
a computer technician or information systems administrator. For the automatic recovery feature 
to properly reboot your system in the event of a crash, you must follow these instructions 

CAUTION! DP-24 devices must always be properly initialized as described in Section 3. If main 
power is lost to a DP-24 and the device is not properly re-initialized, it will power up in an undeter-
mined state when main power is restored. 

Uninterrupted 
Power Supply 
(UPS) 

Adding Crash Recovery
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Activation of Crash Recovery 

To enable the crash recovery program, the PC must be provided with instructions to check 
for the crash recovery files at startup. This is accomplished by placing a shortcut in the 
Windows Startup folder. 

NOTE: This procedure assumes that only one profile (username, password, domain combination) is used 
for running VitalView for data collection. Be sure to use the user-name and password combination from 
this procedure with “Enabling Automatic Logon” which follows. 

For Windows 7

1 Use Windows Explorer to navigate to the VitalView installation folder (typically C:\
Program Files (x86)\VitalView). Double click on the folder.

2 Select “crash.exe” and right click on it. Select “Create Shortcut” from the pop-up menu.

3 Select “crash.exe-Shortcut” and right click on it. Select “Cut” from the pop-up menu.

4 Navigate to C:\ProgramData >Microsoft > Windows > Start Menu > Programs > Startup

5 Open the Startup folder and right click on an empty space. Select “Paste” from the pop-
up menu.

6 Close Windows Explorer.

7 Click the Start button and type “User Account Control” in the search box.

8 Click “Change User Account Control Settings.”

9 Adjust the slider bar on the window all the way to the bottom so that “Never notify” is 
selected.

10 Click OK.

11 If prompted, reboot your computer.

For Windows Vista and XP 

1 Open “Control Panel.” 

2 Open “Taskbar & Start Menu.” 

3 Click ‘Start Menu’ tab, then select ‘Classic Start Menu’, and then click ‘Customize.’

4 Click on Add. 

5 Click on Browse. 

6 Use the scroll bar or expand the folders to find the VitalView installation folder (typically 
C:\VitalView or C:\Program Files\VitalView). Double-click on that folder. 

7 Select crash.exe and click Open or OK. 

8 Click on Next. 

9 Use the scrollbar to find the Startup folder. Click the Startup folder and click Next. 

10 Click on Finish and OK. 

NOTE: The enabling of automatic logon removes password security. If you do not feel comfortable 
making these changes or are unsure if they should be made, we recommend that you seek the 
assistance of a computer technician or Information Systems Administrator. 
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The procedure for enabling automatic logon for the following operating systems can be 
found on the World Wide Web at the Microsoft Support website under the Knowledge Base 
articles indicated. 

• Windows XP -“How to Enable Automatic Logon in Windows XP “Q315231)” http://
support.microsoft.com/default.aspx?scid=kb;en-us;Q315231 

• Windows Vista or Windows 7 -“Turn on automatic logon” http://windowshelp.
microsoft.com/Windows/en-US/Help/e224c60c 0708-48ba-ae97-fcdaddb3dd9d1033.
mspx 

Launching VitalView 

Once installation is complete, you may start VitalView. 

• Select the VitalView program icon from the list of programs found with the Start 
button (Start > Programs > VitalView > VitalView.exe). 

NOTE: If you have installed VitalView as an upgrade, your previous data and configuration files will be 
residing in the folder you renamed per the upgrade installation procedure. 

We suggest at this time you review “VitalView Terminology” in Appendix A in the back of 
this manual. It will familiarize you with the terms used in VitalView. 
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SECTION

HARDWARE INSTALLATION 

This section describes the function of each hardware product, how it is installed, the basic 
principles of operation, and the means to integrate everything into a working system. This 
section assumes that, if necessary, you have already installed the Hardware Interface Card as 
indicated in Section 2, and that you possess basic hardware skills. 

Whether you are assembling a Series 3000, Series 4000, or a hybrid system, this section 
will guide you through the installation process. For illustrations on individual component 
installation, see Appendix B, “Hardware Configurations.”

The diagram below illustrates the order of events required to complete data collection with 
VitalView. 

Flow Chart

Hardware Setup 
Subject Preparation
Sections 1, 2, 3 and 

Appendix

Software Setup
Sections 2, 4, 5,

Data Collection
Section 6

Data Load and Analysis
Section 7
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DP-24 DataPort 
VitalView is capable of supporting ten DP-24 DataPorts. Each DataPort can accept 24 input 
channels from QA-4 Activity Input Modules, or other switch closure devices. Therefore, 
many systems will require only a single DP-24. 

DP-24 DataPort 

1  Connect one end of the C-50 cable to the 50-conductor pigtail, part of the Hardware 
Interface Card. Observe polarity. Either match the little triangle on the connectors, or 
the red stripe on the cable itself. 

CAUTION! The following DP-24 connections (Steps 2 and 3) must be made in the specified order to 
ensure proper initialization. If power is lost to a DP-24 and it is not properly initialized, it may power 
up in an undetermined state. 

2 Connect the 9-volt power supply. The LED on the front panel will confirm power. 

3 Plug the free end of the C-50 cable into either of the “Computer Interface” connectors 
on the back of the DP-24 DataPort. Again, observe polarity. 

NOTE: Maximum length of this cable from PC to the first DataPort is 50 meters. Maximum length of 
this cable between any two DataPorts is 10 meters. 

4  Set the ID switch to “0”. This will be the DP-24 you can assign to all parameters 
monitored by the first six receivers, or to other inputs connected to the DP-24 
DataPort. 

NOTE: Keep the receivers away from the power supply! When plan ning your system setup, always 
plan to keep the DP-24 DataPort power supply as far from the receivers as possible with a minimum 
of 18-inches between them. This will reduce the chances of electri cal noise from the power supply 
interfering with proper telemetry reception. 

Because many systems will require more than six receivers or other inputs, connection of 
additional DP-24 DataPorts will be necessary. For these systems it is necessary to attach the 
DP-24 DataPorts in a “daisy chain.” It is important to observe cable polarity and ID numbers 
for each unit to insure proper data sampling. Units must be assigned ID values in numerical 
order from 0 through 9 in order to take advantage of the automatic hardware setting 

VitalView Hardware

Installing the 
First DP-24

Installing 
DP-24s in 
Series
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features of the VitalView software. When all connections are made properly, both 50-pin 
connectors on all DP-24 DataPorts will be used (with the exception of the last one in the 
chain). Make the connections in the order described below. 

CAUTION! C-50 cables must be kept separate from power cords. These cables are unshielded, and 
susceptible to interference. It is recommended that C-50 cables not be bundled or occupy the same 
run with power cables or telephone cables. 

1 Connect the first DP-24 as described above in steps 1 through 4. 

(Observe the caution in Section 3.) 

2 Connect a new C-50 cable to the remaining open 50-pin connector on the back panel of 
the installed DP-24 DataPort (DataPort 0). 

3 Connect the power supply to the DP-24. 

4 The other end of the C-50 cable will be plugged into either of the 50 pin connectors on 
the second DP-24 DataPort. 

5 Set the ID switch on the second DataPort to 1. This will now be referred to as DataPort 
1. 

 Repeat these steps for every DP-24 added, incrementing the ID switch by one for each 
additional DP-24. 

If using Dual Input Modules, up to twelve receivers such as a TR-3000 can be connected 
to a single DP-24 DataPort using C-8 cables. One end of the C-8 cable is inserted into 
the Data Output port on the receiver. The other is inserted into one of the two, 8-pin 
input connectors on the Dual Input module. The 8-pin plug from the Dual Input module is 
inserted into one of the input connectors on the DP-24 Dataport. 

CAUTION! Keep C-8 cables away from external noise sources, such as power supplies (including the 
DP-24 power supply), florescent light fixtures, electric motors, high capacity relays and switches, and 
other sources of electromagnetic interference. EMI may produce erratic signals and erroneous data. 

*NOTE: The TR 3000 receiver is no longer available. This manual includes this information on the TR-
3000 receiver as support for customers who purchased these receivers in the past.

Complete specifications on the TR-3000 can be found in Section 1. 

TR-3000 

Connecting 
the TR-3000 
to DP-24*

Receiver 
Description 
and Layout
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Activity 

This LED indicates any change in transmitter signal strength detected by the receiver. 
Fluctuations in signal strength are interpreted as activity counts. 

Data Out 

This 8-pin telephone-type (RJ-45) connector is the source of data output from the receiver 
to the DP-24. A C-8 cable is plugged into this connector and one of the six connectors on 
the DP-24 rear panel. 

Aux Inputs 

These two auxiliary inputs and associated LEDs are for switch closure input from activity 
monitoring devices such as running wheels. The LEDs will flash with every switch closure. 

Range Adjust 

This potentiometer allows the user to adjust the operational range of the receiver to fit the 
specific needs of their monitoring equipment. Adjusting the control clockwise decreases the 
reception range; counterclockwise increases the range. Before making any adjustments, we 
recommend you contact a Technical Support Specialist at Starr Life Sciences. 
NOTE: Increasing the range is useful for subjects housed in larger cages. However, this increases the 
susceptibility of the system to electrical noise. Decreasing the range reduces the impact of noise on 
reception. When the control is turned fully clockwise, the range of the receiver is slightly larger than its 
footprint. When turned completely counterclockwise, the range is increased to about 3 inches from the 
outside edge of the receiver. 

Antenna Inputs 

Two external antenna inputs can be installed if the loop antenna input option is specified at 
the time of ordering. If you would like these connectors enabled, please contact us. 

Temperature Monitoring 

Temperature is determined by decoding a string of digital pulses from an implanted 
transmitter. The frequency of these pulses is temperature dependent. The VitalView system 
calculates a mean for the frequency of these incoming pulses and places this value into an 
equation. The equation is further discussed in Appendix D under “Transmitter Sampling 
Theory.” 

Activity Monitoring 

Any change in the signal strength from an E-Mitter is interpreted by the system as an 
indication that the transmitter has moved. This is scored as an activity count. The total 
number of these counts during a sampling period interval or “bin” is recorded by the system. 
This measure of movement is purely qualitative. There is no quantification of magnitude or 
direction of movement. Up to ten counts per second can be recorded. 

Auxiliary Inputs 

Various types of switch closures can be monitored using the receiver. The most common 
type is from running wheels. Cables from the monitoring device can be plugged into either 
of the auxiliary input jacks on the front panel. The switch closures from the sensors are 
recorded identically to activity counts. No more than ten closures per second can be 
recorded per sampling interval, or “bin.” If these devices are to be monitored alone, it is 
possible to attach running wheels to a DP-24 input jack through the use of a QA-4 Activity 
Input Module (see below). 

Receiver 
Functions and 
Accessories
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The QA-4 is a device that accepts switch closures and TTL level inputs. The primary use of a 
QA-4 is to enable connection of switch closure devices to the VitalView system. The QA-4 
accepts closures (up to 10 per second), and converts them into logic level pulses. Active 
circuitry within the QA-4 rejects switch bounce and ringing, resulting in a clean logic output. 

The four input jacks accept two conductor micro-miniature phone plugs. The output is a C-8 
cable. 

QA-4 Activity Input Module 

These two accessories are passive devices that enable the consolidation of two, 2-channel 
devices into one 4-channel DP-24 DataPort input. 

The primary uses of the Dual Input Module are: 
• Connecting two feeding monitors into one input of a DP-24. 
• Connecting two TR-3000s into one input of a DP-24. 
• Connecting a feeding monitor and a TR-3000 into one input of a DP-24. 

There are two models of Dual Input Modules, each with unique configurations. 

Dual Input Module 

QA-4 Activity 
Input Module

Dual Input 
Module
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Dual Input Module – Model A

Jack Input VitalView 
Channel Number

Output VitalView 
Channel Number Data Type

1 1 1 Temperature
1 2 2 Activity
2 1 3 Temperature
2 2 4 Activity

Dual Input Module – Model B

Jack
Input VitalView 

Channel Number
Output VitalView 
Channel Number

Data Type

1 1 1 Temperature
1 3 2 Auxiliary II
2 1 3 Temperature
2 3 4 Auxiliary II

The input and output connectors as well as the LED indicators are located on the front 
panel of the ER-4000 Energizer/Receiver. The functions of each are listed below.

ER-4000 Receiver/Transmitter 

Signal LED 

This green LED will remain illuminated during signal lock with an operating E-Mitter. If it 
remains off, it indicates loss of signal lock. A momentary on-off indicates an activity count. 

Power LED 

This red LED indicates whether power has been successfully supplied to the ER-4000. It 
normally flashes approximately twice per second when power is connected. 

From Computer 

This is a female C-9 connector. C-9 cable connectors from the ER-4 power supply Y-cable, 
or a previous daisy-chained ER-4000 may be connected here. 

To Next ER-4000 

This is a male C-9 connector. The C-9 interlink cable for the next Energizer/Receiver is 
plugged in here. The last ER-4000 in the serial chain will have nothing attached here. 

ID Sticker 

Each ER-4000 is assigned an ID number at the factory. This ID number must be set between 
1 and 32, and must be unique for each Energizer/ Receiver that is included in a serial chain. 

ER-4000 
Description 
and Layout
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We recommend that you not change ER-4000 ID numbers. If you suspect a different internal 
ID than what is seen on the ID label, refer to “ER-4000 ID Problems” in Section 4. 

When planning a layout involving multiple ER-4000s, observe the precautions in Section 3. 

CAUTION! Before connecting, disconnecting, or reconnecting any of the cables in a single or serial 
ER-4000 system, remove power from the system by disconnecting the power supply from the AC 
source. Connecting or disconnecting “live” cables to an ER-4000 may damage the input circuits of 
the receiver.

A single ER-4000, or the first in a series of ER-4000s requires a Y-cable Connector Set. 
The female D-9 is connected to the PC, the other D-9 to the ER- 4000, and the D-5 is 
connected to the power supply. A drawing of this cable can be seen in Section 1. 

Single ER-4000 connections 

ER-4000

AC Power 
Source

Power 
Supply

Y-Cable 
Connector Set

The serial chain consists of ER-4 Power Supplies and a string of ER-4000 Energizer 
Receivers connected to the PC serial port or use a USB to serial port adapter. One power 
supply must be placed in the chain for every four ER-4000s. The first link in the chain must 
have a Y-cable connector set connected to a power supply and a PC. An additional power 
supply unit must be “inserted” into the chain for every four ER-4000s. See the illustration, 
“Connecting the ER-4000 in Series” in Appendix B.

Single 
ER-4000 
Installation

Serial 
ER-4000 
Installation
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CAUTION! Before connecting, disconnecting, or reconnecting any of the cables in a single or serial 
ER-4000 system, remove power from the system by disconnecting the power supply from the AC 
source. Connecting or disconnecting “live” cables to an ER-4000 may damage the input circuits of 
the receiver.

CAUTION! The horizontal distance between ER-4000 receivers must be no less than 8-inches 
(20 cm). ER-4000 receivers must not be placed near sources of electromagnetic energy, such as 
computers and televisions displays, electronic power supplies, telephone cables, etc.

Each ER-4000 has an identification number which can be found on a front panel label. 
Receivers in the chain do not have to be in a specific order, however, it is recommended that 
you use an ascending or descending order of the receivers in each experiment. This practice 
will avoid confusion as to which data belongs to which subject assigned to which receiver. 
Although this order is not imperative, it is essential that the identification numbers of the 
receivers in a chain be different. If there is no identification label on the receiver, the ID 
number can either be recalled or reset. 

It is highly recommended that ER-4000s be installed one at a time and verified before 
installing the next device. If the ID numbers are incorrect, or ER-4000s with the same 
number are connected in the same chain, problems may result. See “ER-4000 ID Problems” 
in Section 4. 

Tecniplast Running Wheels 
Illustrations and directions on assembling the running wheel and magnetic switch can be 
found on “Connection for Running Wheel Magnetic Switch” in Appendix B. 

All mechanical switches used for monitoring must be connected to VitalView through an 
electronic circuit to insure a switch closure is counted as a single event. When mechanical 
switches are activated, they typically close several times in rapid succession. This property of 
switches is called switch-bouncing, and the circuits used to keep the multiple closures from 
being recorded by the computer system are called de-bounce circuits. Two such circuits are 
available for use with VitalView systems. 

If the animal is being monitored by a TR-3000 telemetry receiver, the magnetic switch cable 
can be plugged into one of the auxiliary input jacks on the receiver. These inputs include de-
bounce circuits. 

If TR-3000 receivers are not being used (or if both auxiliary inputs are assigned to lick 
sensors or other units), a QA-4 Activity Input Module can be used to de-bounce the 
magnetic switch signal. 

In either case, an LED indicator next to the jack will light when the switch closes. Each QA-4 
Activity Input Module has four input jacks and its output cable is connected to one of six 
available inputs on a DP-24 Dataport. Therefore, one DP- 24 Dataport equipped with six 
QA-4 Activity Input Modules can accommodate 24 magnetic switches from running wheels. 

1 Plug the cable from the magnetic switch into either an auxiliary input jack on a TR-3000 
Receiver, or a jack on a QA-4 Activity Input Module. 

2 Verify that the power is turned on to the DP-24 Dataport. 

3 Rotate the running wheel and verify that the indicator LED flashes once (and only once) 
with each turn of the running wheel. 

Assembling 
the Wheel

Connecting 
to VitalView
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For manual monitoring, magnetic running wheel switches can be connected to individual 
wheel counters. 

Infrared Motion Detectors 

Motion detectors can be connected to either auxiliary input connector on a TR-3000 
Receiver. For activity-only systems they can be connected to a QA-4 Activity Input module.

1 Plug the detector cable into one of the two auxiliary input jacks on a TR-3000 Receiver. 
Connect the motion detector power supply. The installation is complete. 

2 If using a QA-4, plug the motion detector cable into one of the four input jacks on a 
QA-4. 

3 The 8-pin connector from the QA-4 plugs directly into one of the six, 8-pin input jacks 
on the back panel of a DP-24 DataPort. 

4 Test by noting if the LED on the receiver or QA-4 flashes when motion is detected. 

Series 4000 E-Mitters 

These devices are designed for wireless monitoring of activity, temperature, and heart rate. 
E-Mitters capture energy from the field of radio waves that is set up over the coils of the 
ER-4000 Energizer/ Receiver. Because the receiver energizes them, these devices do not 
require batteries to operate. The energy captured from the electrical field powers the 
circuitry in the E-Mitter and results in a return signal to the receiver. The signal returned 
to the receiver consists of a train of pulses whose period is dependent on temperature. 
Circuits in the receiver convert this pulse frequency into a serial bit stream that can be read 
by a computer. 

Series 4000 Heart Rate E-Mitter and Standard E-Mitter 

NOTE: The G2 & G2 HR E-Mitters are miniaturized versions of the Standard & Heart Rate E-Mitter. All 
functions are identical. 

Connecting 
Infrared 
Motion 
Detectors

Heart Rate E-Mitter

Standard E-Mitter

G2 E-Mitter

G2 HR E-Mitter
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Since E-Mitters have no batteries, they can be stored indefinitely without further 
consideration. Simply store in a location free from excess moisture and vibration. E-Mitters 
do not need refurbishment. 

E-Mitters and HR E-Mitters are nearly identical in size. The primary difference is the HR 
E-Mitter has two sensor leads for heart rate data acquisition. The encapsulation process is 
designed for long-term implantation. The G2 and HR G2 E-Mitters are identical in function 
to their respective counterparts, except much smaller in size. The performance is identical.

 The E-Mitter and G2 E-Mitter gather activity and temperature data. The G2 HR and HR 
E-Mitter also collects heart rate data.

Implantation procedures for both series of devices are located in “Implantation Procedure” 
in Appendix E.

Operational details and description of data acquisition can be found in “Transmitter Sampling 
Theory” in Appendix D.

E-Mitter 
Storage

Series 4000 
Transmitter 
Selection

Implantation

Principles of 
Operation



27

SECTION

SYSTEM SETUP 

Before conducting the hardware and software setups and beginning your experiment, it is 
important to understand the basic concepts of VitalView. 

VitalView is organized in a modular fashion, with each module accessed from the Main 
window. There are also a number of links between the windows. All the windows are 
arranged in essentially the same order you will most likely use them. 

Now that the PC is configured and the VitalView software is ready to run on your PC, the 
VitalView system must be set up. 

VitalView can be thought of as two systems working together. Each one requires 
configuration, or setup. The hardware system assures all the data sensors are communicating 
with the PC. The software system controls the experiment and gathers data. Included in 
the software setups are animal identification and the list of parameters recorded from each 
animal. 

There are four windows on the VitalView Main Window. Each window will be covered in an 
individual section in this manual. 

The Four Windows of VitalView 
• System Setup -Covered in this section 
• Animal & Group Setup - Refer to Section 5 
• Data Collection Monitor – Refer to Section 6 
• Data Load & Analysis – Refer to Section 7

The Five Primary Files of VitalView
These files are discussed fully in Section 6 - “Data Collection Monitor.” 

• .cfg - Configuration 
• .cal – Temperature calibration 
• .evn -Event configuration 
• .log – List of data files 
• .001, .002, .003, .004, etc. – Data files 

Introduction
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The conventions for naming VitalView files are consistent with Windows operating systems.

NOTE: The .evn file is obsolete in VitalView version 5, but is still produced by VitalView version 5 to 
maintain file compatibility with older versions of VitalView.

There are several important functions which take place from the Main window. 

VitalView Main window

Main Window File Menu 

Access: Main window > File

This selection displays a table containing a list of the current set of animal configuration 
data for the currently loaded configuration file. This table contains ID, hardware channel, 
parameter and clipping limit, and interval information for each enabled parameter. This 
information may be printed or saved to disk using buttons at the bottom of the display. At 
VitalView startup, this list will be empty until a previously saved configuration file has been 
opened, or new configuration information has been entered. 

Opens previously saved VitalView configuration files for use or editing. A file dialog will 
appear showing all the .cfg files that are available in the current folder.

This command saves the current VitalView configuration. This configuration file will include 
the current temperature calibration values (*.cal file) and event setup (*.evn file). Whenever 
a configuration is saved, a file dialog will appear showing all of the previously saved .cfg 
files in the current folder. A name for the file may be entered, and the .cfg extension is 
automatically added by the system. 

VitalView 
Filenames
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Configuration

Open 
Configuration 
File

Save 
Configuration 

to File
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After creating (or opening) a configuration for VitalView, this command starts data collection 
at the beginning of an experiment. 

This command halts data collection. A confirmation prompt will be issued prior to shutting 
data collection off in case a mistake was made in selecting this option. In the future if you 
restart data collection using the same configuration, give the new experiment .log file a new 
name. 

NOTE: If you persist in choosing an existing filename, the previous file will be overwritten. 

Password protection is provided to prevent unauthorized persons from tampering with the 
data collection process. 

Access: Main window > File > Password Management

Supervisor Password 

This is used to restrict access to the Password Management dialog box (above). Once a 
password has been entered and the checkbox activated, VitalView will require correct 
entry of the password to edit any of the subordinate passwords. 

Configuration Changes 

When the checkbox is activated, this password protects the system from unauthorized 
editing by restricting access to System Setup and Animal & Group Setup. It also restricts 
Open Configuration File and Save Configuration File from the Main window file menu. 

Start Data Collection 

When this checkbox is activated, data collection may only be started after entering the 
correct password. 

Stop Data Collection 

When this checkbox is activated, data collection may only be stopped after entering the 
correct password. 

Shutdown System 

When this checkbox is activated, VitalView may only be shut down after entering the correct 
password. 

Leaves VitalView and enters the Windows operating environment. This will stop active 
data collection. If this is attempted while data collection is on, the system will produce a 
confirmation prompt. 

Start Data 
Collection

Stop Data 
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This indicator informs you whether VitalView is gathering data or has been taken off-line. 

Introduction 
System Setup provides access to system-wide default settings to setup the sampling routine 
and automatically configure the hardware. These settings are critical to the operation of 
the system. It is essential that they be properly set prior to the initiation of data collection. 
After they have been initiated, the settings will automatically be used for any new animal 
configuration or data collection as part of a .cfg file. They can be manually over-ridden by 
using Animal & Group Setup. 

System Setup consists of five panels, each one related to a specific area. 

Access: Main window > System Setup

NOTE: Values may be changed by clicking in the field and typing in the value, or using the arrows. 
Holding down the shift key will accelerate the change in value. 

Clipping Limit Defaults
Clipping limits specify the acceptable data range for each of the parameters that can 
be monitored by the system. Typically these are set to the physiological limits for that 
parameter.

These values will automatically be inserted into new animal configurations as they are 
created. Later, if you wish to change clipping limits for any particular parameter, you may 
do so in the Animal & Group Setup display. Activity is measured in counts; temperature in 
degrees Celsius; heart rate in beats per minute.

Samples that fall outside the clipping limits will not be recorded in the data file. Instead they 
will be noted by a -10 in the data record. Later, during data analysis, you may elect to “filter” 
data to remove these values. 

On/Off-Line 
Indicator

System Setup Main Window 
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Values
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NOTE: Clipping limits are designed to remove data values that are not relevant to the physiology of the 
animal, and replace them with a –10 value. Setting the values too wide may allow for some irrelevant 
data points to be recorded in the data set. Setting the values too narrow will exclude relevant data. If 
you are testing the system with temperature transmitters at room temperature, please be certain that 
clipping limits are set accordingly.

DP-24 DataPort Configuration 
The DataPort Configuration panel is for use with Series 3000 hardware. The information 
entered is used by the system for automatic configuration and temperature calculation 
purposes. Series 4000 users will only need to use this panel to access the temperature 
calibration display. 

The number of DP-24 DataPorts that are connected to VitalView is entered here. 

This is a buffer that influences the way in which temperature samples are taken for the 
Series 3000 temperature inputs. Unless you are planning to sample from a large number 
of transmitters at a fast rate, we recommend leaving this value at the default value of 256 
samples. For details on temperature acquisition, see “Transmitter Sampling Theory” in 
Appendix D. 

This is the maximum number of different parameters that will be input to the DP-24 on a 
single connector. Up to four parameters may be selected. Usually this number will be set to 
two or four. 

This value is used during automatic configuration to assign hardware channels for Series 
3000 components. Therefore it is important that this value be set properly prior to copying 
animal configurations. 

This sets the rate at which VitalView will sample from a single Series 3000 temperature 
transmitter. Twenty is the maximum number of samples that can be recorded per second by 
VitalView. Unless you are planning to sample from a large number of transmitters at a fast 
rate, we recommend leaving this value at the default of 20 samples per second. (At a rate of 
20 samples per second, it will require 13 seconds for VitalView to fill the buffer to capacity 
with 256 samples.) 

NOTE: Over-sampling is recommended. This will reduce the number of artifacts found in data records as 
a result of sudden changes in body position, or electrical noise which can interfere with the reception of 
radio signals from the implanted transmitters. If you are recording data points every few minutes, then 
default settings for the buffer size and fast sampling rates are recommended. These values should be 
changed if you are recording points from a large number of animals every few seconds. 

This setting determines the first DP-24 ID that will be available for data collection. Each 
DP-24 must have a unique ID value in order to properly report data. This value will 
automatically be written into the DP-24 ID number field of new animal configurations when 
they are created. 
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This button opens the Transmitter calibration display. All temperature.parameters must have 
calibration information assigned to them prior to data collection. Instructions for entering 
calibration settings can be found in the Animal & Group Setup in Section 5. 

ER-4000 Configuration 
The ER-4000 Configuration panel is for use with Series 4000 hardware. 

This is the total number of Energizer/Receivers that will be placed in the serial chain. A 
maximum number of 32 ER-4000 Energizer/Receivers may be monitored by the system. 

This setting determines the number of samples that can be contained in the sampling buffer. 
The default is 120, and it is recommended it not be set to less than 20. For details on Series 
4000 heart rate sampling, see  “Transmitter Sampling Theory” in Appendix D. 

This setting determines the number of samples that can be contained in the sampling buffer. 
The default is 120, and it is recommended it not be set to less than 20. For details on Series 
4000 temperature sampling, see Appendix D. 

This setting determines the COM port VitalView will use to communicate with the serial 
chain of ER-4000 Energizer/Receivers.

This value sets the exponential filter in ER-4000 Energizer/Receivers. The default is 4, and 
this is the recommended setting. This filter is described in detail in “Transmitter Sampling 
Theory” in Appendix D. 

There are also post-collection data filters available in VitalView. These are described in “Data 
Filtering” in Appendix F. 

This activates the ER-4000 utility. This function is described in Section 4. 

Sample Timing Defaults 
This panel allows you to set the default sampling interval. This value will automatically be 
written into the sampling interval field of new animal configurations when they are created. 

Data File Defaults 
This defines the maximum size of the data file. 

Data files will automatically be closed when they reach the size you specify here. A new file 
will begin with the next data record and the same data set name. This has been included 
to make system backup more efficient. Select the file length that best fits your backup 
requirements, or you may select the unlimited option shown above which will create only 
one data file for the current experiment. 

It is possible for the investigator to arrange a variety of sampling intervals, number of data 
collection channels, and experiment durations. However, under the condition that many 
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channels are programmed, the sampling interval is short, and the experiment duration is 
long, an extremely large data set can be developed. This may lead to huge, unwieldy files. The 
longer an experiment runs, the more valuable the data become, so it is well to have several 
shorter data files rather than one large data file. 

If all channels have the same sampling interval (as recommended), you can calculate the file 
size, in kilobytes, for a given file size: 

File size (KB) = 800 x 

The maximum file size is recommended to be no more than about five days worth of data 
based on the above formula. 

If 20 days of data are required and the sampling interval is 300 seconds (5 minutes), and 
there are 24 channels configured, then the file size would be 1,280 KB (1.25 MB) if the file 
were not segmented. This is a small file. However, considering the number of days involved, it 
would be safer for the investigator to limit the file segments to 240 KB . This would segment 
the entire data session into 5 segments of about 4 days each. 

If there are 72 channels configured, the sampling interval is 5 seconds, and the experiment 
session is to last 24 hours, the total file size will be 11,520 KB (11.25 MB). Other 
recommendations apply to extended or long-term data collection: 

• Copy (never move or rename) closed data files to another PC. 
• Use a second computer to load and analyze data files, rather than the computer that 

is being used to collect data. 
• If a crash recovery occurs, stop data collection afterward, archive the data, and start 

the session again with different file names. 

NOTE: VitalView can collect a large amount of data in a very short time. For example, sampling at one-
minute intervals pro duces 1440 points per day per channel. In most cases this number exceeds what is 
required. When selecting a sampling interval, consider the data resolution you will require when reporting 
data. This will indicate the longest sampling interval you should select. We recommend that you sample 
twice as often as this maximum interval in order to allow for some missed samples. 

While VitalView allows sampling intervals from one second to 99 hours, system performance 
will be best at sampling intervals above 15 seconds, and under two hours. A long sampling 
interval (24 hours or more) is useful to count activity over a long period. However, the 
same result can be accomplished with a one or two hour sampling interval, and using the 
decimation and scale filters after the data are collected. Sampling intervals below four 
seconds are not recommend. 

NOTE: If sampling with an interval less than 15 seconds, VitalView may produce variable results. 
Performance will vary between com puters and hardware layouts. We do not recommend you sample 
at these faster intervals unless it is a requirement of your research protocol. Sampling at less than four 
seconds is especially not rec ommended due to the possibility of missed or invalid samples. 

The total number of samples should not exceed three million. If the total number of samples 
expected exceeds three million, one of the following actions should be taken: 

• The number of channels should be reduced. 
• The number of days the experiment runs should be reduced. 
• The sampling interval should be increased until the previous equation shows the 

total number of samples to be less than three million. 
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Introduction 
ER-4000 Energizer/Receivers communicate with the PC via an RS-232 serial 
communications port. These units can be connected in a chain. A diagram of serial 
installation can be found in “Connecting the ER-4000 in Series” in Appendix B. Software 
functions are explained below. 

Initialization of the serial port and communication with the ER-4000 Energizer/Receivers 
is accomplished automatically whenever data collection is started. If the COM port and 
the ER-4000 ID values are already set correctly, communication will be initiated when data 
collection is started. If you are not sure if you have selected the proper port, or you wish to 
check the ID values of your ER-4000 Energizer/Receivers, use the ER-4000 Utility button. 

This button activates the ER-4000 Utility. This display prompts you to check the 
communication between VitalView and the ER-4000s in your system. 

NOTE: At least a 1 must be entered in the “# of ER-4000’s” field. 

Access: Main window > System Setup

ER-4000 Utility Button

Access: Main window > System Setup > Utility 

Each ER-4000 should have a front panel label denoting its ID number. If the label is missing, 
the internal memory of the ER-4000 will still list it on the display. All ER-4000s must have a 
unique ID number. Follow the display instructions and prompts to change the ID number of 
a receiver. 

Communication with ER-4000 Energizer/Receivers

Utility Button
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NOTE: ER-4000 ID numbers appear in arithmetical order, not nec essarily in the order in which they are 
connected in the chain. 

CAUTION! Before connecting, disconnecting, or reconnecting any of the cables in a single or serial 
ER-4000 system, remove power from the system by disconnecting the power supply from the AC 
source. Connecting or disconnecting “live” cables to an ER-4000 may damage the input circuits of 
the receiver. 

There are a variety of reasons an ER-4000 will not appear on the identification list. If the list 
is incomplete or the numbers do not match, first click Refresh to reacquire the list. If the list 
is still incorrect, check the following. Usually, there is a “physical” problem. 

• The power is off. Check the AC supply, plug strip switches, breakers, etc. Verify that
each ER-4000 has power connected to it, and the red LED is lit on each device.

• The Y-Cable connector set is connected improperly, or is faulty.
• Too many ER-4000s connected in series to one power supply, causing an excessive

current drain. A maximum of four devices may be connected to one power supply. It
is likely none of the ER-4000s connected will appear on the ID list.

• The wrong com port is selected on the PC. Refer to Section 4.
• If the power connections appear correct, it is possible that two ER-4000 devices have

an ID #1 assigned to them, or two ER-4000s have the same ID number. To correct
this problem, do the following:
1 Disconnect all but the ER-4000 that has been assigned ID #1. Click on Refresh.

2 Verify that ID #1 only appears on the ER-4000 list.

3 Repeat this process for all ER-4000 receivers, one by one, verifying that each
one has its correct ID. If any receiver has the wrong ID, change it by clicking on 
Change ID #. Remember to re-label that device. 

4  Reconnect the ER-4000 receivers in the system, and verify that all numbers 
now appear correctly. 

• If the red LED blinks, the green LED lights in the presence of an E-Mitter, but the
PC will not communicate with the ER-4000, there is a possibility the ER-4000 com
port circuitry has been destroyed. Although these devices are protected, they are the
interface to the outside world. Improper use of connectors, short-circuited cabling,
environmental contamination, etc., could cause external voltages to destroy these
circuits.

If you continue to have problems with ER-4000 communication, call Starr Life Sciences 
Technical Support. Also check the Troubleshooting section, Appendix I. 

Heart Signal Monitor 
The Starr Life Sciences PDT-4000HR and G2 HR transponders feature wireless 
monitoring of temperature, activity, and heart rate in freely-moving, small laboratory 
animals. The PDT- 4000HR and G2 HR E-Mitters are used together with the VitalView 
Series-4000 data acquisition system to continuously monitor the heart rate. 

The rate of the heart beat is determined by counting the number of R wave pulses within a 
given interval. Accurate rate detection is obtained when good heart beat signals are detected 
by the HR E-Mitter. When implanting the HR E-Mitter, it is important to establish good 
contact between the heart rate leads and the tissue at the contact site. The effectiveness 
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of this contact should be determined prior to closing the incision while the subject is 
anesthetized. In addition, it may be useful to monitor the heart signal following surgery 
to make sure that the lead contact is still secure. The procedure is in the Implantation 
Procedure appendix located under “Confirming the Implant” in Appendix E. 

To assure instantaneous success of the implantation procedure, VitalView provides a 
qualitative monitor of the heart signal via the Heart Signal Monitor utility. The waveform 
displayed with this utility will resemble an ECG waveform. The purpose of the monitor is to 
determine the quality of the lead contact. VitalView filters out all but the Q-T segment of 
the ECG waveform and displays primarily a broadened R wave. 

To access the Heart Signal Monitor, the VitalView system must be off- line. From the System 
Setup window, click Utility. (Utility may also be accessed from Animal & Group Setup and 
VitalView Animal Configuration). Before accessing the Heart Rate Monitor, check that the 
com port is set properly, and the number of ER-4000s is set to 1 or the appropriate number. 
VitalView will then initialize the chain of ER-4000 receivers and display the ID numbers of all 
ER-4000 receivers connected in the chain. 

To monitor the heart signal from an ER-4000, click on the ID number in the list for the 
desired receiver. Then click on the Heart Signal button. When an HR E-Mitter is properly 
implanted, a waveform will be displayed that is similar to the one below. 

Access: Main Window > System Setup > Utility > Heart Signal 

 

Consecutive heart beats are shown as complex pulses progressing along the X-axis. In 
this figure, the R-wave is represented by the relatively strong signal peak rising above the 
baseline. This displayed waveform represents good lead contact. Conversely, if the peak is 
poorly defined, broadened, has low amplitude above the baseline, or spikes appear below the 
baseline, either the lead contact is poor or the subject is not well. Therefore, the investigator 
should try to achieve a lead contact that provides an R-wave with good definition. 

When sutured appropriately into place, the lead contact should not degrade over time. In 
fact, the lead contact can often improve over a period of one to two days after surgery and 
remain constant afterward. It is wise to check the lead contact of each subject on a periodic 
basis, perhaps once per month or at least at the beginning of sequential experiments. 

Accessing the 
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The Heart Signal Monitor is essentially a two-axis graph that continually sweeps and 
refreshes the signal detected by the heart rate E-Mitter. The X-axis (horizontal axis) is the 
time-domain axis and the Y-axis (vertical axis) is directly related (but not equal ) to the ECG 
voltage. 

When the Heart Signal Monitor is activated from the Utility display, the Monitor will 
automatically begin to sweep the signal from the selected ER-4000 receiver. If your setup is 
proper and there is good lead contact, a signal should appear within a few seconds. 

Sweep Buttons 

The three colored buttons at the lower edge of the Monitor control the sweep function. 
Stop halts the sweep indefinitely; Continue resumes the sweep; Exit returns to the Utility 
display. 

Scroll bar 

The scroll bar below the X-axis provides a means to scroll backwards to view pulses already 
detected by the system. Use this feature only when the display is “stopped.” 

Status window 

The window on the lower right provides information about the status of the Monitor. The 
active ER-4000 is indicated in this window as well as instructions on what functions can be 
changed by the operator. 

Styles 

This button changes the “style” of the charted portion of the display, including point size, 
color, chart type, line width and more. These settings will default to the factory settings 
when VitalView is shut down and restarted. 
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SECTION

ANIMAL & GROUP SETUP 

Animal & Group Setup tells VitalView which animals are in the experiment, which data will 
be gathered from those animals, and directs the data to the PC. 

VitalView, when first opened and no configuration file is loaded, has a Default Group 
assigned as a “placeholder.” Group ID will read “Unassigned”, and Group Description will 
read “Default Group.” 

There are sample files included with VitalView. 

To adequately cover Animal & Group Setup, there should be some configuration information 
to observe. For first-time users, we suggest loading the Sample file first. The Surgery file is 
for your convenience for use during the implantation procedure. 

To load and view a configuration file, follow the directions provided in this section. 

Introduction
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Animal & Group Setup Overview

There are several parameters graphically represented by icons that are used frequently 
throughout VitalView.

Note that two of the displays have convenience buttons, enabling immediate access to other 
windows, such as System Setup, and functions such as Temperature Calibration and ER-4000 
Utility. 

A diagram of the animal configuration displays is above. On your color monitor, any field in 
yellow is informative only, and may be edited or affected elsewhere. Blue fields may be edited 
either by typing text directly into the field, or by pop-up lists where the function is selected. 

Parameter 
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Access: Main window > Animal & Group Setup

This is the current animal configuration for the selected animal. This animal is selected 
using Animal ID located under the parameter panels, and via Animal Group. Until animal 
configurations are created, these panels will be grayed out. 

Animal & Group Setup Main Menu Items
Access: Main window > Animal & Group Setup > File

New 

This command clears any currently configured animals and groups and allows you a fresh 
start to create a new sampling configuration. 

Open Configuration File 

Opens an existing configuration file. Configuration files end with the .cfg extension. The 
command is identical to the one in the Main window. The Sample configuration file is being 
used as an example in this section. 

NOTE: Any time you open a configuration file and load it, you will receive a prompt (below) asking if 
you wish to review a summary of it. Clicking on Yes will produce a table with the animal and group 
parameters you have loaded. Other configurations, such as temper ature calibration, will be detailed later. 
Check the index for specific locations. 

.Access: Main window or Animal & Group Setup> File > Open Configuration File > (Load) 

File
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NOTE: A box will appear listing the available .cfg files. Select the file and click to open. 

You may also access the configuration details from the Main window by accessing the File 
menu, and selecting List Sampling Configuration, or the button on Animal & Group Setup. 

Save Configuration to File 

Saves the current Animal & Group configuration along with System Setup information and 
temperature calibration values.

Exit 

Returns to the VitalView Main window. 

NOTE: To exit, you may also use the Escape key. 

Access: Main window > Animal & Group Setup > Group 

It may be beneficial to keep selected animals in groups. A typical experiment might consist of 
two groups, “control” and “experimental,” or “daytime” and “nighttime.” 

New 

This command creates a new group in which to place animal configurations. It is advised to 
create experimental groups prior to the animal configurations. It is easier to assign them to 
experimental groups as they are created than it is to assign them later. 

Edit 

Edit opens a group, and enables you to change the Group I.D. and Group Description. It 
also displays the number of animals in the group. When the group values are changed, all the 
animals in that group will be affected. 

Delete Group 

This will delete the active Group I.D. The Delete All Animals in Group option enables you 
to delete all animals in the group. If the animals are not deleted, they will be placed in the 
default group. (The default group cannot be deleted even if it has been renamed.) 

Delete Group Animals 

This command deletes all the animals in an experimental group, but leaves the Group I.D. 
and Group Description unchanged. 

Introduction 
A sampling configuration is a complete set of sampling instructions for the VitalView 
System. It includes the system configuration information from the System Setup as 
well as all individual sampling instructions for each animal. Each subject will have its own 

Group

Setting Up a Sampling Configuration
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Animal ID and sampling instructions called an animal configuration. Within an animal 
configuration are individual parameters, or measurements. Subjects may be organized into 
an experimental group. 

Parameters Animal configurations

This system is capable of monitoring up to five parameters per animal configuration. In 
many cases a single parameter will be monitored for each animal, therefore only a single 
parameter will be set up in the animal configuration. 

NOTE: Before you begin, enter the System Setup settings for hard ware, sample times, and clipping limits. 
Assignment of the hardware channels, as well as defaults for sampling interval and clipping lim its, will be 
determined using these settings as a guideline. 

1 From Animal & Group Setup, Group > New or Edit.

Access: Main window > Animal & Group Setup > Group > New

Creating 
or Editing a 
Group
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2 In the Group ID box, click and type in the Group ID, or edit the existing ID. For example, 
you might first create the “Experimental” Group. 

3 In the Description field, you can enter any details or leave it blank. 

4 When you are finished, click OK. 

5 You may repeat this process to create additional groups. 

Animal configurations consist of information such as the Animal ID and Group ID values as 
well as all of the parameter settings that direct VitalView to sample appropriately. 

Your first configuration may serve as a template that can be copied. Large numbers of animal 
configurations can be created with a few clicks of the mouse. 

The Animal Editor may be accessed in two ways: 
• From the Animal menu item, select New or Edit. 
• From Animal & Group Setup, click anywhere within a parameter panel. 

Access: Main window > Animal & Group Setup > (click within any parameter panel) 

Animal ID 

Identification may be assigned with the Animal ID dialog box. For now this will not be 
important. Wait to assign the actual ID for your subject when you have created the sampling 
configuration and have actually assigned cages and transmitters. 

Access: Main window > Animal & Group Setup > Animal > New

Group ID 

The Group ID assigns the above animal to an experimental group. If no group has been 
created, the animal will be assigned to the default group “Unassigned.” If you wish to create 
experimental groups, refer to “Creating or Editing a Group” in this section. 
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Animal Icon 

There are several animal icons from which to choose. They can be used to organize the 
animals. 

Changing Parameters 

Animal parameter settings may be changed by using the arrows, click and-wipe, or double-
clicking. 

In VitalView Animal Configuration, there will be five panels as illustrated below. These 
correspond to the five possible parameters that may be monitored for any single animal ID. 

Parameters may be entered individually for each animal, or entered for the first animal and 
copied for all subsequent animals. 

Each parameter has its own panel. Begin with the top panel. If you require additional 
parameters for the selected animal, use the remaining panels. 

Access: Main window > Animal & Group Setup > (click within any parameter panel) 

In the example above, data are being collected on “Subject 4” (see “Animal ID”) from an ER-
4000. Temperature, activity, and heart rate are enabled. Note the parameters that are not 
used are disabled. 

Parameters that require transmitters or E-Mitters will include the serial number and 
calibration data (see “Temperature Calibration Values” in this section). 

Access: Main window > Animal & Group Setup > (double click within any parameter panel) 

1

2

3 4 5 6 7 8
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There are a variety of data collection devices listed. Access by clicking the parameter 
selection field. 

Access: (There are multiple access methods. See text.) 

Access: Main window > Animal & Group Setup > (multiple access methods)

If transmitters or E-Mitters are used, their serial numbers are shown here. If no serial 
numbers are listed in this menu, click on the convenience button Temperature Calibration, 
and load serial numbers and calibration values (see “Temperature Calibration Values” in this 
section).

Clicking this button will notify the system that this parameter is available for data collection. 
The button will turn green when enabled. 

Enter the ID for the DP-24 DataPort that will receive the input for that parameter. A 
maximum of ten DataPorts with ID’s 0-9 can be serviced in one system. Assign ID values to 
the DataPorts in the order of attachment to the PC bus. The first DataPort should be 0, the 
second one 1, and so forth. 

Selects the number that corresponds to the port on the DP-24 into which you plugged the 
receiver cable. There are a total of six connectors per DataPort, labeled “Data Inputs.” 

If you are using ER-4000s, enter the ID number of the ER-4000. This number (1 - 32) should 
be on the front panel of the ER-4000. If it is not, you may find the ID number in the on-board 
memory using the ER-4000 utility. See Section 4 for details. 

Selects the channel number on the connector selected above. If the first parameter is 
temperature, set the field to channel one. 

Each connector of a DataPort is capable of monitoring four channels, 1 through 4. One 
channel should be assigned to each parameter in an animal configuration. 

The following chart shows the correlation between parameters, sensors, and available 
channels. 

1 - Selected 
Parameter

2- Calibration

3 - Enable

4 -DP-24 ID#

5 - Con

6 - Chn
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The following table lists the parameters, the sensor types, and the channels that are available. 

Parameter Sensor Type Available Channels

TR-3000 Temperature Transmitter 1,3*
TR-3000 Activity Transmitter 2,4*
TR-3000 Lick Lick Sensor 3,4**
TR-3000 Running Wheel Magnetic Switch 3,4**
QA-4 Lick Sensor Lick Sensor 1,2,3,4
QA-4 Running Wheel Magnetic Switch 1,2,3,4
Feeding Frequency IR Feeding Monitor 1,3*
Feeding Duration IR Feeding Monitor 2,4*
Other Switch Closure IR Montion Detector 1,2,3,4

*Second channel available with Dual Input Module 

**Channel 3 available when connected to Aux 1, and channel 4 available when connected to Aux 2. 

The following table defines the field values used in building a configuration. 

Field Label Series-3000 Receiver, FH-
Series Transmitter

Series-4000 Receiver, 
E-Mitter Transponders

DataPort Numbr “DP-24 ID#” 0 through 9 Placeholder only. Use 0 
through 9 buth not a DP-24 
ID number already used

Connector Number “Con” 1 through 6 1 through 32
Channel Number “Chn” 1 through 4 1 through 3

Access: Main window > Animal & Group Setup > (double click within any parameter panel) 

If you are using model FH transmitters: 

First field corresponds to the DP-24 DataPort ID, labeled “DP #” on the DP-24. Valid numbers 
are 0-9. 

Second field is the connector (socket) number on the DP-24, labeled “Data Inputs” on the 
DP-24. Valid numbers are 1-6. 

Third field indicates the channel in the C-8 cable the data signal will travel from the receiver 
to the DataPort. Valid numbers are 1 through 4. 

If you are using model PDT or G2 E-Mitters: 

First number is a place holder only. This number can be any digit from 0 to 9 but cannot be 
a digit assigned to a DP-24 ID number. 

Second number is the ER-4000 ID number. Unless reassigned, this number will be on a front 
panel label of the ER-4000. Valid numbers are 1-32. 

Third number is the data source in the ER-4000. Valid numbers are 1 through 3, corresponding 
to temperature, activity, or heart rate. 

The following table organizes the previous information differently to show the relationship 
between the channels and the type of data carried. 
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Device Channel 1 Channel 2 Channel 3 Channel 4
TR-3000 
Receiver

Temperature Activity Aux 1 (switch 
device only)

Aux 2 (switch 
device only)

ER-4000 
Receiver

Temperature Activity Heart rate 
(only with HR 
E-Mitters)

QA-4 Activity 
Input Module

Ch 1 input 
(switch device 
only)

Ch 2 input 
(switch device 
only)

Ch 3 input 
(switch device 
only)

Ch 4 input (switch 
device only)

Dual Input 
Module

Input 1 (“Ch 1 
& 2”)

Input 1 (“Ch 1 
& 2”)

Input 2 (“Ch 3 
& 4”)

Input 2 (“Ch 3 & 
4”)

Infrared 
Feeding 
Monitors

Feeding 
frequency

Feeding 
frequency

Five Channel Selection 

Each connector on a DataPort is capable of monitoring a maximum of four parameters. 
However, each animal configuration can contain five parameters. It will be necessary to 
connect one of the parameters to a different DataPort connector. 
1  In System Setup, select four channels per connector. 

2  Create your first animal configuration with only four parameters enabled. Make sure that 
all telemetric parameters are accounted for via one of the first four parameters, with 
consecutive channel numbers (from top to bottom) 1, 2, 3, 4. 

3  Copy this configuration as many times as required. (You may use the auto-index feature.) 
The physical connection for additional behavioral inputs such as running wheels or 
motion detectors is made using a QA-4 behavioral input module. These parameters can 
be added to existing animal configurations, but must be assigned to different connectors 
using the QA-4. 

Hardware Channels for Series 4000 

The same fields are used to assign the hardware channels for Series 4000 systems. The 
following are instructions for setting up the Series 4000 hardware to monitor PDT-4000 and 
G2 E-Mitters. If you wish to monitor behavioral inputs such as running wheels or montion 
detectors, some Series 3000 hardware is required. These inputs would be configured as 
previously described. Both series may be simultaneously run using the same system. 

Series 4000 is a serial system requiring a COM port for communication. You may wish to 
test the ports on your PC to establish or confirm their ID. Few PC manufacturers accurately 
label these ports. To test the COM port, please refer to System Setup in Section 5. 
1 The first field has no direct function for Series 4000 hardware. It is only necessary to 

enter a digit in the range from 0 to 9. However, the digit entered must not be a digit used 
for any DP-24 ID number. 

2 Enter 1 in the Con field to set the first Energizer/Receiver ID in the chain. ER-4000’s 
are assigned an ID at the factory. This number is noted on a front panel label. To limit 
confusion, we recommend that the units be placed successively in the chain as they 
extend from the PC serial port. 
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NOTE: If it is necessary to change an ER-4000 ID, it can be done through the ER-4000 Utility. See 
Section 4. 

3 There are requirements for channel (Chn) assignment: 

• Temperature must be assigned to channel one 
• Activity must be assigned to channel two, 
• Heart rate must be assigned to channel three. 

 The first temperature channel for the first animal configuration should have hardware 
settings as follows: 

• Con = 1 
• Chn = 1 

Default Values 

When a new parameter is selected, VitalView will automatically fill in the clipping limits and 
sampling interval fields. These default values may be changed via the System Setup window. 
Any parameters that are entered after these defaults are set will use the new values. 

NOTE: VitalView can collect a large amount of data in a very short time. For example, sampling at one-
minute intervals pro duces 1440 points per day per channel. In most cases this number exceeds what is 
required. When selecting a sampling interval, consider the data resolution you will require when reporting 
data. This will indicate the longest sampling interval you should select. We recommend that you sample 
twice as often as this maximum interval in order to allow for some missed samples. 

NOTE: If you must sample with an interval that is less than 15 seconds in length, you may find that 
VitalView may produce variable results. VitalView performance will vary between computers and 
hardware layouts. We do not recommend you sample at these faster intervals unless it is a requirement 
of your research protocol. Sampling at less than four seconds is especially not recommended due to the 
possibility of missed or invalid samples. 

Unequal Sampling Intervals 

Normally, investigators will find it reasonable and prudent to configure all channels of 
an experiment with the same sampling interval. We encourage the use of equal sampling 
intervals for all channels. However, VitalView offers improved flexibility allowing some 
channels to be sampled with different sampling intervals. When this option is used, there are 
some restrictions that apply: 

• The Data Load and Analysis function will only allow you to load channels with the 
same sampling intervals. 

• If you want all data from all channels to load as one data set, you must assign the 
same sampling interval to each channel. 

• Since the various channels are sampled concurrently, the channels displayed in the 
Data Collection Monitor window will not be updated simultaneously. The channels 
with the shorter sample intervals will be updated more often than those channels 
with longer sample intervals. 

• Various error checking and data collection pace preserving facilities of VitalView only 
apply when all enabled channels are configured with the same sampling interval. If you 
set different sampling intervals on different channels, you will be giving up the ability 
that VitalView otherwise has to preserve the pace of data collection across a stop 
and restart of data collection. 

7 - Sampling 
Interval
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Long-Duration Data Collection 

Through the use of VitalView, it is possible for the investigator to arrange a variety of 
sampling intervals, number of data collection channels, and experiment durations. However, 
under the condition that many channels are programmed, the sampling interval is short, and 
the experiment duration is long, a very large data set can be developed. This may lead to 
large data files. The longer an experiment runs, the more valuable the data become, so it is 
well to have several shorter data files rather than one large data file. 

Fortunately, VitalView contains a feature that allows the investigator to split or segment data 
files into any number of equal-size files. This feature can be invoked from the System Setup 
window by entering a number for the maximum file size (see Section 4 for details). 

Clipping limits are boundaries for acceptable data. Default settings can be chosen in System 
Setup. If you wish to change them for a single Animal ID, use VitalView Animal Configuration. 
The units automatically update to those appropriate for the parameter being monitored. 
Data values outside the clipping limits will be replaced with –10. 

NOTE: Clipping limits are designed to prevent the recording of data values that are not physiologically 
reasonable for the subject. These unreasonable data points are replaced with a –10 value. Set ting the 
clipping limits too widely may allow some unreasonable data to be recorded. Setting the clipping limits 
too narrowly may exclude reasonable data.

NOTE: Series 4000 E-Mitters and G2 E-Mitters respond to temperature values in the range of 25° C 
to 42° C. If an E-Mitter is monitored in an ambient environment colder than 25° C, spurious data may 
result. HR and G2 HR E-Mitters will not provide heart rate signals when used at temperatures below 
25° C. 

Temperature Calibration Values 
For those researchers who are monitoring temperature with model FH transmitters, PDT 
4000 E-Mitters, or G2 E-Mitters, it is necessary to enter temperature calibration values to 
ensure maximum measurement accuracy. 

You may elect to enter calibration values and assign the transmitters to specific Animal 
ID’s at any time prior to the start of data collection. These values will be saved in a .cal file 
when data collection is started, or when the VitalView configuration is saved. Temperature 
data displayed in the Data Collection Monitor or the Data Load & Analysis displays will be 
calculated using the calibration values entered here so it is important that they are entered 
correctly. 

NOTE: Calibration values are used to convert transmitter frequency values to ° C. If the incorrect values 
are assigned to a temperature channel, data values can vary significantly. Check each transmitter serial 
number and calibration information before starting data collection. Transmitters must be recalibrated 
each time the battery is changed. E-Mitters and G2 E-Mitters should be recalibrated periodically to 
maintain 0.1° C accuracy. 

You may enter the Temperature Calibration display from several “convenience panels” 
throughout VitalView. From the Animal and Group Setup, click on Temperature Calibration. 
(If in System Setup, press the CAL button in the DataPort Configuration panel.) The 
VitalView Temperature Calibration panel will appear.

8 - Setting 
Clipping 
Limits

Entering 
Temperature 
Calibration 
Values
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 Access: Main window > Animal & Group Setup (or Configuration > Temperature Calibration 

If you are editing a previously used configuration, any transmitters for which calibration 
values have been entered previously will be displayed in the Current Temperature 
Transmitters and E-Mitters list. If you are creating a new configuration, the list will be empty. 

NOTE: Do not delete the default line: NA 0.00 0.00 0.00. 
1  Select the type of receiver (Series 3000 or Series 4000). 

2  Locate the calibration values on the temperature calibration sheet. 

3  Enter the Serial Number for the first transmitter in the Serial # box. This number may 
be found at the top of the temperature calibration sheet. 

4  Enter the low calibration temperature value. For E-mitters, this value must be 37° C. 

5  Enter the frequency that appears on the calibration sheet next to the low temperature 
you have selected. 

6  Enter the high calibration temperature value. For E-Mitters, this must be 41° C. 

7  Enter the frequency that appears on the calibration sheet next to the high temperature 
that you have selected. 

8  When the chosen values are entered, open the Setup menu and select “Add Current 
Transmitter.” The transmitter just entered will be added to the list. 

Repeat the process for any additional transmitters. If you have selected the same calibration 
temperatures for all the transmitters, you will only need to change the Serial Number and 
frequency values. 

Once values have been entered, the serial numbers for these transmitters will now be 
available in the Animal & Group Setup when you are ready to assign transmitters to animals. 

When you have entered all the transmitters to be used for the current experiment and their 
proper calibration values, you may save them. 

NOTE: When saving .cal files from the Cal Display, you must assign it the same name as the associated 
.cfg file. You may also save the .cal file from the Main window, or Animal & Group Setup. 

Saving 
Temperature 
Calibration 
Values
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1  Activate the File menu. 

2  Select Save Calibration Info. 

3  The calibration information will be saved in a .cal file that can be used later. These files 
are always saved automatically when data collection begins. They are assigned a file name 
matching the experimental .log file. 

If you wish to enter new data for a transmitter already in the list: 
1 Highlight the transmitter or E-Mitter that you wish to edit. 

2 Enter the new values. 

3 Activate the Setup menu. 

4 Select Replace Highlighted Transmitter. 

1 Highlight the transmitter or E-Mitter that you wish to delete. 

2 Activate the Setup menu. 

3 Choose Delete Highlighted Transmitter. 

4 The selected transmitter or E-Mitter will be removed from the list. 

To load a previously saved set of values: 
1 Activate the File menu. 

2 Select Load Calibration Info. A list of the .cal files in the current folder will be displayed. 

3 Select the file containing the calibration data you require and click on Open. The values 
contained in that file will appear in the list. 

Accepting the Animal Configuration 
Once you have completed the parameter settings, exit and return to the Animal & Group 
Setup display. 

Note the following: 
• The animal panel has been updated to reflect the parameters that are now enabled. 
• The parameter settings are all filled with values set by the user. 
• Green indicator lights will show which parameters are enabled. 

If all of your experimental animals will be sampled identically to the configuration you have 
created, proceed to Copying Animal Configurations which follows. If you require additional 
animal configurations, you may create additional templates before proceeding. 

To fill experimental groups for your project, you can create each animal configuration 
manually or copy a template. If several animals have similar settings, you will avoid repeating 
steps by copying a template. Any animal configuration can serve as a template. The 

Editing 
Calibration 
Values for a 
Transmitter

Removing a 
Transmitter 
from the 
Calibration 
List

Loading Saved 
Temperature 
Calibration 
Values

Copying Animal Configurations
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configuration you choose must be the active animal configuration in the Animal & Group 
Setup display. To determine which Animal ID is active, check the Animal ID field. 
1 From the Animal & Group Setup display click and hold on the blue Animal ID field and 

select an ID from the pop-up list. 

2 Activate the Animal menu and select the Copy command. 

3 Follow the instructions from the display. 

Access: Main window > Animal & Group Setup > Animal > Copy 

4  Click OK. 

5 The ID values for all animals produced by copying will be altered slightly from the 
template. A number will be appended to each name. The template will receive a one, the 
first copy a two, and so on. 

6 Assign transmitters to each temperature parameter. 

It will be necessary to do multiple copy procedures. For example, here is the procedure to 
copy a template to two groups. 

The first group is filled as previously described. Make sure to include one additional copy. 

Multiple 
Experiment 
Groups
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The additional copy will be the template for making the other group. 

It will be necessary to change the group ID in the template configuration to be used for the 
second group. After this has been completed, make as many copies as needed. 

Saving, Loading, and Editing Configurations 

After creating a set of animal configurations, you should save this information to a disk file. 
Do this from the File menu of either Animal & Group setup, or the VitalView Main window. 
The configuration will be saved in a .cfg file for use later. 

Any time you start data collection, the current configuration will also be automatically saved. 
It will be saved under the same filename as the .log file, but have a .cfg extension. 

VitalView automatically adds the extension. This command saves temperature calibration 
values in a .cal file, and event schedules in a .evn file. These files will all have the same file 
name. They will be saved wherever you have set the path. 

Previously saved sampling configuration files can be opened and loaded from the Animal & 
Group Setup display, or from the File menu of the Main window. Select Open Configuration 
File from the File menu and follow the prompts.

The ID and description of any group can be edited, including the default or “unassigned.” 
(Follow the directions on in Section 5). 

You can delete any experimental group (except the default group) from the list of groups in 
the Animal & Group Setup display. 
1 Click and hold on the Group ID field. Highlight the Group ID you wish to delete in the 

pop-up list and release the mouse button. 

2 The selected Group ID will appear in the group panel. The on-line status, description and 
list of animals in the group will be indicated. 

3 From the Group menu, select Delete Group. In the Delete Group window, the Group 
ID will be displayed. If you wish to delete all of the animals in this group, remove the 
checkmark from the box labeled Delete All Animals in Group. 

NOTE: The Unassigned group is the Default Group. This group cannot be deleted from the sampling 
configuration. It can be renamed if you wish to make one of your experimental groups the default. If 
animal configurations are kept when a group is deleted by deactivating the Delete All Animals in Group 
box, they will be placed in the default group by the system (see below for details). This will occur even if 
you have changed the default group name or ID. 

Any setting for an animal configuration can be edited using the Animal & Group Setup editor. 
1 Open the Animal & Group Setup display. 

2 Click and hold on Animal ID. 

3 Move the highlight bar in the scrolling pop-up list to the Animal ID you want to edit. The 
configuration for that animal will appear. 

4 From the Animal menu select the Edit command or click on the parameter icon to edit. 

Saving 
Configurations

Loading 
Previously 
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Configurations

Editing an 
Experimental 
Group
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Experimental 
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Configurations
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5 Edit the parameter settings as required. 

6 When finished, click OK. 

There are three ways to delete animal configurations. They can be deleted one at a time, 
multiple animals deleted at once, or all animals in one group can be deleted. 

Deleting One Animal Configuration 
1 Enter the Animal & Group Setup display. 

2 Click in the Animal ID field and hold. 

3 Highlight the Animal ID you wish to delete. 

4 From the Animal menu, select Delete Current. 

5 Confirm the deletion by selecting OK at the prompt confirmation. 

Deleting Whole Groups of Animals 
1 Enter the Animal & Group Setup display. 

2 Click and hold on Group ID. 

3 Highlight the Group ID you want to delete. This Group ID and all information about this 
group will be displayed in the group panel of the Animal & Group Setup display. 

4 From the Group menu, select Delete Group Animals. 

5 Confirm the deletion by selecting Delete at the prompt confirmation. 

Deleting a Selection of Animals 
1 In the Animal menu of the Animal & Group Setup display, select the Delete Multiple 

command. A list of currently defined animals will be displayed. 

2 Any single animal may be chosen for deletion by highlighting it with the mouse. By 
holding the shift key and clicking, multiple animals may be highlighted. 

3 Select OK to delete the highlighted animal configurations. 

4 Confirm the deletion by selecting OK at the confirmation prompt. 

Deleting 
Animal 
Configurations
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SECTION 

DATA COLLECTION MONITOR

This is where the actual experimentation begins. This section covers collection of data, the 
storage of data, and monitoring the experiment. VitalView file types were introduced in 
Section 4, System Setup. The following details the application of these files, and how they 
relate to data collection. 

Prior to beginning the actual experiment, it is recommended you run a test to confirm 
proper setups. See Appendix C, “Pre-Experiment Test.”

These files are the VitalView application itself as well as supporting applications that are 
required for power failure recovery and loading. 

Introduction

File Types

Executable 
File (*.exe)
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These files contain saved animal configurations and System Configuration information. They 
can be saved, edited, and reloaded as required. System configuration files may be stored 
in any location, but it is recommeneded they be stored in a sub-folder dedicated to data 
collection. System configuration files have the .cfg extension. 

When data collection is started, the current system configuration is saved as a .cfg file 
automatically by the system. This file is assigned a name to match the .log file name you 
select when you start data collection. This information will be preserved for automatic 
recovery in case of a system crash. 

These files contain all event schedules and links between event schedules and parameters 
and/or control relays for an experiment (VitalView 4.2 or earlier).

Experiment files are ASCII files with the .log extension. Each time a new data acquisition 
session is started, a new experiment file is written. It is named according to the filename you 
enter when prompted by the system. The role of the experiment file is to act as a pointer 
for the VitalView system during analysis. In the file is the name of the experiment, its start 
and stop times, and the names of all the files to which data have been written. It directs the 
data loading activities, and helps keep track of data files. This information will be preserved 
for automatic recovery in case of a system crash. 

If an experimental .log file is deleted or overwritten accidentally, data files may still be 
accessible. Refer to “Restore VitalView Log File” in Section 8. Do not edit this file. 

Data files are designated by a file name with a three-digit extension (e.g. datafile.001). 
VitalView creates data files by attaching a three-digit extension to the experiment name 
selected at the start of data collection. The first data file, which is designated with the 
extension .001, is continually written as data are collected. When the first data file reaches 
a preset size, VitalView automatically closes that file and creates a second data file with the 
extension .002., as shown in the illustration at the beginning of this section. 

This process is continued indefinitely throughout the experiment. The circumstances that 
determine the file segment length are: 

• The file length set in the System Setup window. 
• A power failure or crash recovery closes the previous data file and creates a new 

one in the series. 
• A data file analysis load closes the current data file and creates a new one in the 

series. 
• A disk write error closes the current data file and creates a new one in the series. 

These files contain all transmitter or E-Mitter calibration information entered from the 
Temperature Calibration display. When you select the Save Calibration Info command from 
the File menu of the Temperature Calibration display, a .cal file is created. This file may be 
loaded later for use, or used with the current sampling configuration and event configuration 
to form a complete VitalView system configuration. 

This file is written by the system when you initiate data collection. It will be erased if 
VitalView is exited normally, or data collection is stopped. Should the system be shut down 

System 
Configuration 
File (*.cfg)

Event File 
(*.evn)

Experiment 
File (*.log)

Data File 
(*.###)

Temperature 
Calibration 
File (*.cal)

Autorecovery 
File (crash.
rec)
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without exiting normally, this file is not erased. Its presence will automatically trigger the 
automatic recovery module to initiate data collection when the computer is rebooted. 

These files are data link library files containing information that is not always required for 
system operations. They are commonly used for application software because they allow the 
system to utilize less RAM than it would otherwise require. When the information in these 
files is required, they are read by the system. 

CAUTION! All files created by VitalView are integral to the secu rity of collected data. NONE of the 
.exe, .cfg, .evn, .log, .###, .cal, .rec, .dll, .lrm, .ini, and serpdrv files should be modified in any way after 
the start of data collection or after data collection is termi nated. Doing so will almost certainly result 
in the loss of some or all collected data. 

NOTE: In order to remove the possibility of program or resource conflicts during data collection, it is 
strongly recommended that you dedicate the PC to data collection operations exclusively. Before starting 
data collection, it is wise to shut down any other programs that are running. 

Before beginning data collection, there are pre-experiment requirements: 
• The VitalView hardware must be installed and connected as instructed in Section 2. 
• There must be a complete system setup, including the following: 

• System setup data as instructed in Section 4. 

• Animal & Group Setup, including temperature calibration values and transmitter 
or E-Mitter assignment, as covered in Section 5 (see note below). 

NOTE: VitalView will not begin data collection until each tempera ture parameter has been assigned a set 
of calibration value. If this information is missing, VitalView will prompt you. Instructions are in the Animal 
& Group Setup section in Section 5. 

Suggestions for Long Term Data Collection 

For customers performing data collection sessions that extend past one month or 500,000 
data records, we recommend the following steps be taken. 

Uninterruptable Power Supply 
• Use an uninterruptable power supply (UPS) for all VitalView components. 

Separate collection and analysis computers 
• Your VitalView license agreement allows you to install VitalView on the PC used for 

Data Collection, and to be installed on a PC used for Data Analysis. 

Check Data Collection clock status weekly 
• Activate the System Setup display and confirm that the clock settings for the PC 

clock are updating and are accurate. 

DLL File 
(*.dll)

Before Data Collection Can Begin



58

Use a separate PC for Data Analysis review 
• It is highly recommended that the data be moved to another computer for viewing 

and analysis if VitalView is still collecting data. VitalView will tolerate viewing and 
collection at the same time, but there is a risk that more resources may be required 
than are available. This may lead to irregularities in the data collection. Read this 
section thoroughly for more information. 

Weekly data backups are recommended 
• Backing up your data is always recommended in long-term research. Refer to 

“Backing up Data Files” in Section 7. 

NOTE: Prior to beginning data collection, it is highly recommended that a test of all equipment and 
parameters be conducted as detailed in “Pre-Experiment Test” in Appendix C. 

1 From the File menu, in the Main window, click on Start Data Collection. 

Access: Main window > File > Start Data Collection

2 An alert window will appear that lists two choices. 

• Test Option 

If this option is selected, VitalView will start data collection with a test configuration in 
which all sampling intervals have been set to 15 seconds. This test will continue until you 
stop data collection. For this reason, this option should only be selected if you expect 
to be present long enough to check the setup, stop data collection, and re start with the 
standard configuration. 

• Standard Option 

If this option is selected, VitalView will start data collection with the configuration that 
was set up for the actual experiment. 

Without regard to which option has been chosen, VitalView will attempt to 
communicate with all ER-4000 receivers that are configured in the system. 

To Start Data Collection
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Access: Main window > File > Start data collection > Test or Standard 

3 If ER-4000 receivers are included in the system, VitalView will communicate with each 
one and list all receivers that were identified. Verify that all receivers in the chain have 
been identified and listed in the window. 

4 If necessary, you may change the ID numbers of any ER-4000 receivers in the chain. Click 
Change ID #. When you are sure that all ER-4000s are listed correctly, click on List is 
OK. 

 If there are no ER-4000 receivers assigned to this experiment, VitalView will skip steps 3 
and 4. 

NOTE: If you have neglected to assign transmitter or E-Mitter cali bration values, VitalView will not go on-
line. A prompt will direct you to assign proper values. 

5 When prompted, enter a text comment, e.g. Experiment B, Session 2, relating to the 
experiment description, and click OK. (This name will appear in several displays, such as 
the head of the ASCII file data outputs, etc). 

6 At the File Dialog, use the “Up One Level”, “Open”, and “Create New Folder” buttons 
as necessary to navigate to and create a folder for the experiment log file and data files. 
We recommend that this folder not be the same as the folder containing VitalView 
installation files. Click on the File name field and type a name for the experiment log 
file. It is not necessary to type the .log extension. This will be added automatically. When 
satisfied with the location and name you have chosen, click the Save button. 
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 A display will appear to control the start of data collection. 

Access: (see procedure) 

7 Confirm the current configuration is as intended by using the buttons provided in the 
lower right of the “System is ready” display (not including the Data Load button, which 
has a different purpose - see Appendix G). 

8 Confirm the date and time reported by the “System is ready” display are correct. If 
they are not, the next step depends on whether you are starting the first session for an 
experiment or a subsequent session for a continuing experiment. 

First session 
• Reset the PC clock via the taskbar or by clicking the Start button, and selecting 

Settings > Control Panel > Date/Time. You do not need to cancel from the “System 
is ready” display to reset your PC clock. 

Subsequent session 

Do not reset your PC clock unless it is extremely inaccurate. See “Starting a Seamless 
Second Session” in Appendix G. 

9 If the Pre-set Time shown is not appropriate for data collection to start, change it by 
clicking either of the two buttons just below “Start Collection at Pre-set Time”, or by 
entering directly into the blue Date and Time entry fields. Set Pre-set Time results in a 
pre-set time that is recommended based on the longest sampling interval configured in 
Animal & Group Setup. “Set to next hour” will also set a recommended pre-set time, 
but may be further in the future than is practical for short sampling intervals. Click Start 
Collection Now to start data collection immediately. This is not recommended except 
for quick pre-experiment tests where the data collected will not be joined to any other 
data. 

NOTE: There is an important reason to start data collection on the hour, or at a time that is a whole 
increment of the sampling interval after the hour. This will preserve the pace of the data collection 
from one session to a subsequent session. Realistically, in a typical long duration experiment, there is 
a probability that VitalView will need to be stopped before the experiment has been completed. In this 
event, data collection will have to be re-started (see “Starting a Seamless Second Session” in 
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Appendix G). If all sessions are begun with data samples taken on the hour (or at times that are whole 
increments of the sampling interval after the hour) then all sessions will have the same “pace” of data 
collection. If all sessions have the same number of parameters configured and the same sampling 
interval for each parameter, the sessions can be joined into one contiguous or “seamless” set of data 
with a constant pace of data collection throughout the experiment. (See“Joining Files” in Appendix H) 

10 Click on “Start Collection at Pre-set Time”. The following display will be seen until the 
PC clock catches up to the Pre-set Time. 

Access: (see procedure) 

11 When the PC clock passes the Pre-set Time, VitalView will go on-line and begin 
collecting data, as indicated by the green flashing indicator in the Main window. If possible 
(i.e., your sampling interval is not long), confirm the readings for all parameters are 
reasonable (via the Data Collection Monitor button from the Main window). 

If the Test option was selected in step 2, see “Pre-Experiment Test” in Appendix C. After 
verifying that VitalView is collecting data as intended (according to Appendix C), stop data 
collection and re-start beginning at step 1. At step 2, select the “Standard” option for the 
first session of the actual experiment. 

Backing up Data Files 
All data files will be given the experiment filename plus a numerical extension. The maximum 
size for data files is set in System Setup. All data files will be uniformly sized, unless the 
system has been shut down due to a disk write error, power outage, or if the data have been 
loaded to the analysis buffer during data collection. 

You may want to occasionally tidy up the VitalView folder. We suggest that you back up any 
data files, .log files, .cfg, .cal, .evn, and .cal files prior to deleting any files. We also suggest that 
data be kept in folders not in the VitalView installation folder. 

You may elect to save certain .cfg, .cal, and .evn files for future use. However, if these are 
lost, you can rebuild them from within the program. This is also true of the .log file (Main 
Window > Data Load & Analysis > File > Restore VitalView Log File). Data files cannot be 
restored. 

CAUTION! Deleting any of the following files will cause VitalView to cease functioning. 

File Management

Which Files 
to Keep
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Do not delete: 
• Files with an .exe extension. 
• Files with a .dll extension. 
• Files with an .lrm 
• Files with an .ini. 
• serpdrv 
• crash.rec file. 
• The folder named “tmp_lvrteinstalldir” 

This procedure may be used at any time from any VitalView window. During long 
experiments, it is recommended data be backed up approximately every seven days. 

1 Click Start on the Windows taskbar. 

2 From the Programs menu, start Windows Explorer. 

3 Navigate to the folder that holds the files for the current experiment, and open the 
folder. 

4 Sort the files by name, e.g. Windows Explorer > View > Arrange Icons > Name. 

5 From the list, find the five file-types for the current experiment. They will be labeled per 
the following format (these are examples): 

990924.cfg System Setup and Animal & Group Setup file 
990924.cal Supplementary configuration file - temperature calibration values 
990924.evn Supplementary configuration file - event setup information 
990924.log Log file for the experiment - a list of data files 
990924.001 1st data file 
990924.002 2nd data file 
990924.003 3rd data file 
990924.004 4th data file, etc. 

6 While holding down Ctrl, click on each file of the current experiment. As an alternative, 
you may use the Windows Explorer or the method of your choice. 

NOTE: Be sure to copy all the data files, from .001 through the last .xxx file. If the last file is missing, the 
data loading process will be more difficult. 

7 When the appropriate files are highlighted, use the drag and drop method to copy them 
to a safe place. 

NOTE: Make sure the Ctrl key is depressed during the entire copy process. It is very important that the 
files be copied rather than moved. 

8 When the copy process is completed, confirm that the copies exist both in the original 
and the destination folder. If they do not exist in the original folder, they were likely 
moved rather than copied. Copy them back to the original folder immediately. 

It is highly recommended that the data be moved to another computer for analysis if 
VitalView is continuing to collect data. Although VitalView will tolerate viewing and analysis 
at the same time as data collection, it is not recommended because analysis of large 
data files may require more resources than are available, leading to irregularities in data 
collection.

Copying Files 
While On-
Line
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Loading Data for Viewing, Analysis, and Export 

While VitalView is on-line, the most recently collected data may be used. 

1 From the VitalView Main window, click Data Load and Analysis. 

2 Click on File, and Load From VitalView File. 

3 Open the experiment .log file. If VitalView is currently on-line, you will receive a 
CAUTION. 

4 If you click Continue, VitalView will close the data file currently being written, and 
automatically start a new data file. This will allow you to load, view, analyze, and export 
the most recent data. 

NOTE: These activities can consume excessive PC resources and are not recommended while VitalView is 
on-line. The recommended procedure is to copy the data files to another PC. 

Further information on data analysis is located in Data Load and Analysis, Section 7 of this 
manual. 

Should your PC lose power, VitalView Crash Recovery will immediately initialize when the 
PC is restarted (see “Adding Crash Recovery” in Section 2). This module will direct data 
collection to resume. In addition, the previous data file will be closed and a new one started. 
The new file will have an incremental extension, e.g., .001 to .002. 

If the VitalView program is exited in an abnormal fashion while data collection is underway, 
the crash.rec file will not be deleted. This file is written when data collection is initiated and 
contains the names of all the system files needed to restart data collection. Its presence 
in the program folder will trigger the automatic recovery executable file to restart the 
program and re-initiate data acquisition. The .cfg, .evn, and .cal files that were last utilized will 
be reloaded and a new data file will be started automatically. When you are ready to analyze 
data, the break in data collection will be recognized by the system. To set up Crash Recovery, 
see “Adding Crash Recovery” in Section 2.

The Data Collection Monitor provides an overview of the current data collection process. 
Usually this display will be left on your monitor when the system is collecting data. 

Crash 
Recovery File

Data Collection Monitor Display
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Access: Main window > Data Collection Monitor 

The Data Collection Monitor consists of two columns of 12 panels each, creating a “page.” 
If you are collecting data for more than 24 parameters, you can scroll through the pages. 
Panels may be sorted by Animal ID, Group ID, or parameter. 

File Menu 

This option inserts an instant event marker during data collection into the Marker current 
data file. No text other than an event number may be added. Therefore, it is important that 
you keep a manual log of each event. 

Access: Main window > Data Collection Monitor > File > Insert Event Marker 

To insert an event marker: 

1 Highlight the parameter you wish to mark. 

2 Enter the event marker number to represent this event. 

3 Click Insert Marker. 

4 Click Exit. 

5 Instant event markers can be viewed after data loading from the VitalView Analysis zoom 
display (see “Analysis Zoom” in Section 8). 

Insert Event 
Marker
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These commands enable you to either scroll through multiple pages of panels, or direct a 
sort of the panels. 

Access: Main window > Data Collection Monitor > Display

Scroll Forward 

Enables you to move forward through the pages of indicator panels. 

Scroll Backward 

Enables you to move backward through the pages of indicator panels. 

Sort By Parameter 

This command places all the parameters of one type together. For example, all activity 
parameters may be grouped. 

Reset to Original Animal ID Order 

This command enables you to reset the indictor panels to the order originally set via Animal 
& Group Setup. 

Sort By Group ID 

This command enables you to sort the indicator panels according to the Group ID. 

NOTE: We strongly recommend that you close all other applications when VitalView is collecting data. It is 
possible for other programs to interfere with data collection. 

Access: Main window > Data Collection Monitor 

Click anywhere in here to zoom

Parameter icon Last value taken

Thumbnail

NOTE: VitalView will replace any data values that exceed clipping limits with a –10 value. Clipping limits 
should always be checked prior to beginning data collection to insure that valid data values are not 
unintentionally excluded from the parameter (see Section 5, “Setting Clipping Limits”). 

Monitoring Data Collection

Display Menu
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Data Collection Zoom Display 

To activate the Zoom function, click anywhere left of the thumbnail in any of the parameter 
panels within the Data Collection Monitor display. 

Access: Main window > Data Collection Monitor > (click within a parameter) 

This display shows a graph of the last 128 data samples recorded for a single parameter. 
When a data value is recorded, it is placed at the right edge of the display. You may use the 
“grasping hand” to tug the chart to the left. As each new point is added, the chart scrolls to 
the left. When the system has recorded the 128th value the chart will be full, and the data 
values move off the chart. Therefore, the number of points will never exceed 128 in the 
monitor. 

If you wish to view data values collected prior to the time displayed on the left edge of the 
chart, refer to Section 7, Data Load and Analysis.

The chart will automatically add newly collected points as they are recorded. The last 128 
points can be displayed in the chart window. Updating is on by default when VitalView is first 
run. All chart controls and scaling settings will remain until the zoom window is exited. Even 
though the display is “frozen,” data continue to accumulate. 

The X-axis will automatically be set to include 128 samples across the chart without regard 
to the sampling rate. Automatic scaling will remain active unless you turn it off by toggling 
the Autoscale button. 

The Y-axis will automatically be set to include the entire range of the 128 points of collected 
data. Automatic scaling will remain active unless you turn it off by toggling the Autoscale 
button. 

The functions of the toolbar in the zoom display are explained below. Before using the 
Magnifying Glass and Grasping Hand, the X-Axis and Y-Axis Autoscale should be toggled off. 

Access: Main window > Data Collection Monitor > (disk within parameter)

Data Chart

Update is 
ON/OFF

X-Axis 
Autoscale is 
ON/OFF

Y-Axis 
Autoscale is 
ON/OFF

Tool Pallet
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1 and 2 - X & Y Axis Autoscale Defaults 

 To avoid confusion with the autoscale buttons on the far right side of the panel, it is best  
not to use (1) and (2) as controls. Instead, use the autoscale buttons on the far right side 
of the panel.

3 Magnifying Glass 

 This tool is for changing the chart resolution by clicking, or clicking and dragging on a 
region of the chart for closer study. When you click on this tool button, a pop-up menu 
appears. Any of the Magnifying Glass modes modify the chart window. The selected mode 
will remain active until you choose another. When active, the magnifying glass button will 
be depressed. 

4 Undo Zoom 

 Click this button to avoid changing the scale or chart position inadvertently. It is still 
possible to manually change the scale of the chart by inserting the cursor in the field 
containing the maximum or minimum values. 

5 Panning Tool (Grasping Hand) 

 Enables you to grasp a portion of the data and drag it to any place in the chart. The axis 
scaling automatically adjusts to accommodate the change. This is a preferred tool to 
center the data of interest within the chart window prior to zooming. When the area of 
the chart is selected, the open hand changes to the grasping hand. 

 For additional information on the tool pallet, see Section 8. 

• First, toggle the X and Y Auto Scale buttons so they are OFF. 
• Click on either the minimum or maximum value in either the X or Y-axis, and enter 

the value. 
• To return to the Data Collection Monitor, click the X in the upper right corner. 

This function is used when calibrating transmitters used with the TR-3000 receiver. 
By default, frequency values are converted to temperature values using the calibration 
information assigned during configuration. When this button is activated, VitalView will 
display the incoming frequency rather than the temperature. Click the button to turn off the 
conversion. It will read TR3000 Hz is On when frequencies are displayed. 

These statistics are for all valid data collected for the parameter since the start of data 
collection (or since a power failure recovery). Data samples detected as invalid or that have 
been clipped are not included. 

Manually 
Entered 
Scaling Values

TR3000 HZ is 
OFF

Min, Max, 
Mean, 
Statistics
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SECTION

DATA LOAD & ANALYSIS

VitalView loads, filters and analyzes multiple data sets. A data set may contain the data for 
a single parameter or multiple parameters from one, or a whole experimental group of 
animals. 

Four steps to data analysis in VitalView: 
• Load data from data files. 
• Examination of data charts. 
• Application of optional data filters. 
• Output of processed data to other file formats. 
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NOTE: Analysis operations are very different from the others in VitalView. There are some new terms that 
will be used frequently in this chapter. If unfamiliar with a particular term, refer to Appendix A, VitalView 
Terminology. 

Loading Data
Step 1 - Open Data Load & Analysis  Step 2 - Data Load & Analysis Display     Step 3 - Choose Data    

Step 4 - Wait for loading            Step 5 - Data displayed                           Step 6 - Zoom Display 

The data loading procedure is accomplished from the Data Load & Analysis display. 

1 Open Data Load & Analysis (step 1 above). The four plot display will appear (step 2). 
From the File menu, select Load From VitalView Data File. With the file dialog, navigate 
to and choose the experiment log file to open. 

2 Once an experiment log file has been opened, the data set(s) of the experiment will be 
displayed (step 3). Select parameters that all have equivalent sampling intervals. Multiple 
parameters can be loaded by holding down the shift key or the control key and selecting 
with the cursor. Press and hold down the control key while typing “a” to select all 
parameters (the parameter selection list must be clicked on first).

3 Select the Invalid Point Marker value. This is an important field to note for several 
reasons. 

 If there were any clipped or invalid data points detected during data collection, these will 
be set to the Invalid Point Marker value. Use the default “Not a Number” (NaN) setting 
if you do not care to see the time distribution of invalid points in the VitalView charts 
displayed after loading. 

 An advantage of the NaN setting is that the charts will be appropriately auto-scaled. This 
permits you to see your data immediately without having to manually adjust the chart 
scales or use zoom functions. NaN will treat invalid data points as “blanks” in the data. 

 The number of invalid points in each channel, and the ratio of valid to invalid points will 
be displayed in the lower right of each chart. 
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 If you want to see the time distribution of invalid points, set the Invalid Point Marker to a 
value of –10 (-10 to -9999.99 is allowed). 

NOTE: If NaN is in the Invalid Point Marker field, you will have to click on the field and enter a number. 
The scrolling arrows will only work with numbers. To accelerate scrolling, press the shift key. 

4 Carefully check the following statements. If they are all true, you may click OK and 
proceed (a and b are mutually exclusive). 

a If the current time is Daylight Saving Time and the log file creation date/time is also 
Daylight Saving Time. 

b If the current time is Standard Time and the log file creation date/ time is also 
Standard Time. 

c The data you are loading were collected in your time zone rather than mailed to 
you from another time zone where the data were collected. 

d The sampling interval of the parameters you have selected for loading is 2 minute 
or longer, or 5 minutes or longer if you have more than 50 parameters selected. 

e The data you are loading spans more than 1 day and less than 6 months, and you 
want to load the full time span of the data. 

f You think you have less than 1,000,000 data samples selected for load (total samples 
= number of parameters multiplied by number of days, multiplied by 86400, divided 
by the sampling interval in seconds). 

If all of the above are true, click OK, follow the prompts, and wait for VitalView to load the 
data. 

If one or more of the previous statements are not true, follow the directions below in the 
order given. 

• If (a) applies and is not true: Click the “Spring time change?” button to Yes. 
• If (b) applies and is not true: Click the “Fall time change?” button to Yes. 
• If (c) is not true: Click the “Time zone offset” control arrows until the Log File 

Creation Time matches that displayed by the PC that collected the data. This 
only matters if you want your data outputs to match the times shown by outputs 
produced by the data collection PC in the other time zone. (If you leave the Time 
zone offset control at its default of 0 hours, the timestamps of the data samples will 
be interpreted as though they were being collected by your PC at the exact real time 
they were being collected in the other time zone.) 

• If (d) is not true, and any of (a) through (c) that apply to you have already been 
addressed: Click the “Special span” button to “Yes”. Then click on the blue “Date” 
field under “To” to drop the cursor there, and enter a date that is much closer to 
the true data end time than is the default 6 months from data start (this assumes 
that if your sampling interval is this short, you have much less than 6 months of data). 

• If (e) is not true, and any of (a) through (c) that apply to you have already been 
addressed: Click the “Special span?” button to “Yes”. Then click on the blue “Date” 
field under “To” to drop the cursor there, and enter a date for the end of the data 
load. If wanted, do the same for the “Time” field, and also the “Load Data From” date 
and time fields. Data will load from the entered “From” data/time to the entered 
“To” date/time.  

• If (f) is true, we recommend you load a single parameter first to get some idea of 
how long the full set of data will take to load. this will also allow you to see the exact 
start and end date/times of the data. 
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Click OK, and follow the prompts if they apply, and wait for VitalView to load the data. 

Once the data are loaded, the first four data sets in the list of loaded parameters will be 
displayed in the four panels of the Analysis display. These panels allow you to preview the 
loaded data, or to compare between data sets. 

NOTE: Raw data charts may look different than you expect. Most often this will be due to the chart 
scale. VitalView will automatically set the X and Y-axes to include the minimum and maximum values. 
These values may be changed at any time, by simply typing new val ues on the axis of your choice. 

It is likely that you will need to load data from more than four parameters at once. You may 
choose which data set to display in each panel of the Analysis display by simply clicking any 
of the four chart titles. Each shows a pop-up list that contains all the currently loaded data. 

The Analysis display consists of four analysis panels into which different data may be loaded. 
These panels allow you a cursory view of the data as well as a listing of statistics. The title of 
each chart is a pull down menu that zooms in on that particular parameter. 

The .log file from which the data have been loaded will be displayed in the lower left corner 
of the display. 

Physiological parameter statistics are displayed beside each of the four plots in the Analysis 
Display. These statistics are: 

• Number of samples 
• Sampling interval 
• Minimum of the data 
• Maximum of the data 
• Standard deviation of the data 
• Scale Factor 
• Data Display Offset 

Access: Main window > Data Load & Analysis

It is important to remember that these statistics are calculated using all data for that 
particular parameter, including occurrences of “-10”, or “NaN”. If NaN was selected as the 
invalid data marker during data load, then several statistics will have values of NaN. To re-
calculate the statistics, all occurrences of the invalid marker must be removed using the 

Analysis Display
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Invalid Points Filter (see “Invalid Points” in Appendix F), and the data for that parameter re-
displayed. 

File 
Access: Main window > Data Load & Analysis > File 

This command loads data from files stored in the VitalView format. Data may be converted 
to ASCII, Actiview (.awd), and tau (.chn) after loading. 

This command is used as part of the file joining process (see “Joining Files” on page H-1), 
for rebuilding the .log file from an original log file that has become lost, or was inadvertently 
deleted or corrupted. 

This command converts data currently in the Analysis Buffer into a comma or tab delimited 
ASCII file. Most PC programs can read these files. 

This command converts data from VitalView data files to TAU .chn files format. TAU files 
contain data from a single parameter only. Therefore, this operation will produce multiple 
files that may each be loaded to TAU for circadian rhythms analysis. 

This command converts VitalView data to ASCII files modified for use by the ActiView utility. 
ActiView generates actograms and performs circadian analyses. These files all have the .awd 
extension. 

Select this command to return to the Main window. 

Analysis 

This command enables the application of various mathematical filters and other data 
operations to the specified data set(s). Data filtering will be important to those users who 
are monitoring radio transmitters or E-Mitters in order to remove the effects of electrical 
interference or other artifacts affecting the raw data. 

The filters are explained more fully in “Data Filtering” on page F-1. 

Plot Buttons 

Access: Main window > Data Load & Analysis 

This command will produce a plot in which the four data sets displayed inthe Analysis display 
will be superimposed upon one another for comparison on the same set of axes. 

Load From 
VitalView 
Data File
Restore 
VitalView Log 
File

Save to ASCII 
File

View Data to 
TAU Chain

View Data to 
ActiView File

Exit

Filter Data

Four Plot 
Overlay
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When clicked, this command will produce a plot in which the four active data sets displayed 
in the Analysis display will be stacked in a column, each with its own set of axes. 

Analysis Zoom 

By clicking on a chart panel, Analysis Zoom is enabled. A data chart for the chosen data set 
will appear for closer inspection. 

Main window > Data Analysis > (click on chart panel) 

The Chart Window displays all data collected during the interval specified when loading 
the data. Unless auto scaling has been switched off (see below under zoom pallet), both X 
and Y-axes will automatically scale to accommodate the full range of data. It is important to 
set the clipping limits for each parameter before starting data collection to eliminate the 
inclusion of data points that are outside the physiological limits. 

You may change the X or Y axis scale by simply clicking on either the minimum or maximum 
value and entering the one of your choice. Before you do this, unlock the X or Y autoscale. 

The zoom tool pallet is the small display of tools to the right of the chart.

The pallet has controls for panning and for zooming in and out of sections of the graph. 

If you press the X autoscale button (b), VitalView autoscales the X data of the graph. If you 
press the Y autoscale button (e) VitalView autoscales the Y data of the graph. If you want 
the graph to autoscale either of the scales continuously, click on the lock switch (a) to lock 
autoscaling on. 

The scale format buttons (c and f) give you run-time control over the format of the X and Y 
scale markers respectively. 

Normally you are in standard operating mode, indicated by the plus (h). Click this button to 
avoid changing the chart scale inadvertently. 

If you click on the grasping hand (i) (panning tool), you switch to a mode that enables you to 
scroll the visible data by clicking and dragging sections of the graph. 

Four Plot 
Stack

Zoom Tool 
Pallet
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If you choose the magnifying glass (g) (zoom tool), you can zoom in on a section of the 
graph by dragging a selection rectangle around that section. If you click on the magnifying 
glass, you get a pop up menu you can choose the various methods of zooming. 

This function toggles recorded events on or off and displays them on the chart. If there are 
many events, this may take a moment to generate. 

• Each event is represented by a black dot on the chart. Clicking on an event in the list 
will change the dot to red. 

• If there are numerous events in one area, it may be necessary to zoom on the group 
to single out an event. 

• You may save the event list for any data set to an ASCII file. The contents of the file 
may be viewed using Notepad, Wordpad, or any other text editor. 

Access: Main window > Data Load & Analysis > (click within chart panel) > Events On/Off

In addition to viewing the four data panels in Data Load & Analysis, there are three options 
for viewing data. 

The options are accessed via the buttons in the Data Load & Analysis display. 

Access : Main window > Data Load & Analysis 

Scaling 

The Y axis in either display may be adjusted by inserting the cursor in the minimum or 
maximum value, and typing in the new value. Press Enter and the scale will automatically 
update. 

Printing 

Print the stacked charts by clicking Print Window. 

This is detailed in “Analysis Zoom” in Section 8. 

Events On/
Off

Viewing Data Charts

Zoom Display
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Access: Main window > Data Load & Analysis> Four Plot Overlay 

By placing more than one data set on the same axes, differences between them may become 
evident. You may plot up to four parameters in four colors. The legend appears at the 
bottom of the chart. 

Stacking the charts of multiple parameters permits visual comparison. 

Access: Main window > Data Load & Analysis > Four Plot Stack 

 
VitalView data files are a specialized format that cannot be read directly by other programs. 
The format is specific to the requirements of the VitalView program. These files can easily 
be converted to ASCII format for importation to other programs. Instructions are included 
below. Instructions for importing an ASCII file generated by VitalView into Microsoft Excel® 
are included in the next section. 

1 Load the data of interest into Data Load & Analysis (see Section 7). 

Four-Plot 
Overlay

Stacking 
Charts

Converting VitalView Data Files to ASCII
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2 Apply any applicable filtering (see Appendix F). 

3 From File, select Save To ASCII File. 

4 Follow the on-screen directions to select the format in which to save the data. 

5 Select the destination drive and folder for the ASCII file. 

6 Enter a filename for this file. The .asc extension will automatically be appended. 

When the conversion is completed, the file will be given an .asc extension, and the program 
will return to the Data Load & Analysis display. 

It is possible to save several versions of the data to file as you apply different filters, or 
include different combinations of parameters. 

ASCII text files generated by VitalView can be imported into most programs. The 
instructions below are for importing an ASCII file into Microsoft Excel, however most 
programs will have a similar series of commands. 

1 Open the Excel application. 

2 From the File menu, select Open. 

3 Navigate to the folder in which the VitalView data files are saved. 

4 Direct the browser to list All Files (*.*). 

5 Select the .asc file to be opened and click Open. 

6 The Excel Text Import Wizard will open.

Access: Excel > File > Open > (ASCII data file) 

7 Select the Delimited button, and click Next. The next Wizard step will appear. 

Importing ASCII Files into Excel
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8 Select either Comma or Tab delimited, depending on how the ASCII file has been saved. 
Click Finish. 

 The data will appear in Excel in column format. 

 The header information at the top of the file keeps track of the origin of the data 
file and provides basic information including start and stop times as well as the text 
description entered when data collection was started. 

 A block of information for each data set is also included at the beginning of the file. This 
contains the ID values, sampling intervals, clipping limits, and number of records. There 
will be a header for each of the data sets. 

 Data sets are ordered according to the number of records they contain. The data set 
containing the largest number of records will be listed first in the ASCII file. The data set 
containing the least number of records will be listed last. This convention handles data 
sets with parameters sampled at different intervals. 

 Each data set will have three columns of information. The first column will contain the 
date for each record. The second column will contain the time of each record. The third 
column will contain the data value.

 Date Time Data value 

 The header for each data column will be truncated to save space. By clicking on a cell, 
the entire contents may be read. By double-clicking on a column, the column may be 
resized to fit the largest entry. 
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The TAU export function allows you to convert data from VitalView data files to the 
TAU .chn files format. TAU files contain data from a single parameter only. Therefore, this 
operation will produce multiple files that may each be exported to TAU for circadian 
rhythms analysis. 

1 From Data Load & Analysis, select File > VV Data ? TAU Chain. 

2 From the list, select the data sets to be converted. Click OK. 

3 Navigate to where the chain files are to be saved, name the file, and click OK. The file will 
be converted, given an extension, and saved. 

In the above example, several files are highlighted. As the files are converted and saved, each 
one is automatically incremented. 

Access: Main window > Data Load & Analysis > File > VV Data  ?   TAU Chain

The ActiView export function included with VitalView enables the conversion of data files 
to the .awd ASCII format required by the ActiView program. ActiView is a program that 
provides several different forms of circadian rhythm analyses. 

1 From Data Load & Analysis, select Load Data From VV File. Load the data files to be 
converted to the ActiView format. 

2 Select File > VV Data ? AWD. 

3 Navigate to where the .awd files are to be saved, name the file, and click OK. The files 
will be converted, labelled with the .awd extension, and saved. 

4 These files can now be opened in ActiView for analysis. 

Converting Data to TAU Chain Files

Converting VitalView Data to ActiView Format
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APPENDIX

VITALVIEW TERMINOLOGY 

Animal Configuration 

An animal configuration is a complete collection of parameter settings for a single Animal 
ID. For example, the configuration for the Animal ID “Animal1” might include settings for 
three parameters: heart rate, activity, and temperature. 

Auto-Indexing Hardware 

This feature will automatically assign a hardware channel for each parameter in each of 
a given number of animal configurations copied from a template animal configuration. 
Auto-indexing provides an easy method to set up a complex experiment in an orderly 
fashion. System setup must be properly established before copying animal configurations. 

.awd file 

A modified ASCII file used by the ActiView utility for generating actograms and 
performing circadian analysis. 

Channels 

Channels are pathways for the data signal of a single parameter. Each parameter must 
be assigned its own path. This “path” contains three numbers. For example, a complete 
channel designation might be 2,5,1. Each number has a special definition, depending on 
the hardware used. 

Connector 

A connector is defined as any jack (female) or plug (male) on a VitalView hardware 
component or cable. 

Control Fields 

Control fields are colored light blue, and can be edited by the researcher using common 
tools, such as clicking on arrows, etc. (see Indicator Fields) 

Data Filter 

A mathematical manipulation of raw data for purposes of smoothing, increasing 
resolution, or changing scale. 

Data Set 

Data records for one parameter that have been loaded for plotting, filtering, or other 
purposes. 
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Events 

Events are occurrences that the user wishes to note in the data record during an 
experiment. An event may relate to one or more animals. 

Files Organization 

You may elect to save any file in any directory while in VitalView. We suggest that you 
develop a system of file organization so that it will be easy to locate saved files when you 
wish to use them later. Horizontal order (many folders and few files) is easier to access, 
but tends to get cluttered. Vertical order (fewer folders, but many files) is tidier, but fewer 
files are visible. 

Hardware Configuration 

The layout and interconnection of hardware components, including interface cards, 
DataPorts, receivers, and other system components needed for a research project. 
More information on hardware configurations can be found in Section 2, Hardware 
Installation. 

Indicator Fields 

Indicator fields are colored yellow, and cannot be edited. (see Control Fields). 

.log file 

An ASCII file used by the system to coordinate data analysis for a single data 
collection. Also see Section 6. 

.log file vs data file 

A .log file is an ASCII file that contains a list of the data files created during a data 
collection session. The filename for this list is determined when data collection is started. 
VitalView automatically appends the .log extension to the filename. One of these files must 
be selected in order to instruct VitalView where to look for data to load. 

Data for a single experiment are actually contained in a series of numerically ordered 
files. You will never open one of these files directly. Their length corresponds to the 
system configuration setting for file length made prior to initiating data collection. 

Parameter Settings 

Sampling instructions for one physiological or behavioral parameter, such as temperature. 
Settings are controlled by one of the five boxes within the Animal and Group 
Configuration display. This is discussed in detail in Section 5, Animal & Group Setup. 

 Sampling Configuration 

A sampling configuration is a complete collection of animal configurations and 
experimental group information for VitalView. Sampling configurations may be saved to 
disk for repeated use when an experiment is replicated. Activating Save Configuration 
from the File menu in the Animal and Group Setup display or the Main window can save 
the current sampling configuration. Sampling configurations are saved in files with a .cfg 
extension 

System Setup 

The system setup is a set of default instructions for VitalView. Default instructions set 
characteristics such as the sample buffer size and data file limits. These settings are saved 
in a file with a .cfg extension. These settings originate in System Setup. 
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Temperature Calibration Values 

Calibration values are empirically determined frequency values acquired from model 
-FH transmitters or E-Mitters at known temperatures. These values are used by 
the system to accurately determine temperature. Before beginning data collection, 
calibration values must be entered in the transmitter list. These values will be saved in a 
file with the .cal extension. 

VitalView Configuration 

A VitalView configuration is a comprehensive term consisting of the system setup and 
sampling configuration settings and temperature calibration information. 
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APPENDIX 

HARDWARE CONFIGURATIONS 

The following illustrations may be of help in setting up the VitalView hardware. A large, 
complete VitalView system can be intimidating if seen as a whole picture. However, when 
broken down into the fundamental components, VitalView is quite simple. 

Included in the following pages are a few representative devices and layouts commonly found 
in customer facilities. 

• Running wheel with magnetic switch 
• QA-4 
• Feeding monitors 
• DP-24 in Series 
• Dual input module 
• TR-3000 
• Lick sensors 
• Transmitters 

Assembling the Wheel 

1 Place the two halves of the stainless steel cage lid on the plastic cage. One half is the 
sheet lid; the other side is the activity wire lid containing the food hopper and water 
bottle compartment. 

2 Slide the running wheel onto the axle of the wheel hub and support unit. Secure by 
threading the knurled stainless steel retaining nut snugly onto the end of the shaft. Assure 
that the wheel spins freely on the shaft. Lower the complete wheel assembly into the 
opening in the sheet lid until it rests securely. 

3 Test the wheel by spinning it to make sure it turns freely. If it touches the top of the 
sheet lid, bend the lid slightly away from the wheel to provide clearance. Note that the 
weight of the wheel will keep the animal from pushing its way out through this opening 
as long as the wheel turns freely. If rotation of the wheel is blocked, e.g., excess bedding 
in the cage, the animal can climb the wheel and possibly escape. 

Connection for Running Wheel Magnetic Switch
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How the Wheel Turns are Counted 

The Starr Life Sciences system for counting wheel turns consists of a magnet attached to 
the flat back part of the wheel, and a magnetic switch mounted on the wheel support 
unit. Each time the wheel rotates the magnet within range, the switch closes and a turn is 
counted. 

Attaching Magnetic Switch and Magnet 
NOTE: The position of the magnet as it passes the switch is impor tant for proper turn counting. If the 
magnet is too far away from the switch as it passes, the switch will not close and no activity will be 
recorded. If the magnet is too close, the switch will close once as the magnet approaches, and again as it 
departs. This will result in a double count. Follow the instructions carefully. 

1 Mount the magnetic sensor to the wheel support unit with the thumbscrews provided.

2 The strain relief cable clamp is mounted in the center screw position as shown below.

3 The bracket is universal for either rat or mouse cages. Shown below are the two ways in 
which to mount the sensor.

Use these mounting holes 
for mouse cage.

Mount this direction for mouse cage.

Mount this direction for mouse cage.

Use these mounting holes 
for rat cage.

NOTE: Mount with the cable strain relief clamp so that the cable is held away  from the cage. This will 
reduce the risk of cable damage due to rodent chew. 

Mouse Mount

Rat Mount
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4 Mount the magnet on the wheel. Remove the paper from the adhesive square. Mount 
the magnet horizontally over one of the holes in the wheel per the illustration on the 
following page. 

5 Plug the connection cable into the sensor. There is only one way in which the cable can 
be inserted into the sensor. 

Connecting Running Wheels to VitalView 

All mechanical switches used for monitoring must be connected to VitalView through an 
electronic circuit to insure a switch closure is counted as a single event. When mechanical 
switches are activated, they typically close several times in rapid succession. This property of 
switches is called switch bouncing, and the circuits used to keep the multiple closures from 
being recorded by the computer system are called de-bounce circuits. Two such circuits are 
available for use with VitalView systems. 

If the animal is being monitored by a TR-3000 telemetry receiver, the magnetic switch cable 
can be plugged into one of the auxiliary input jacks on the receiver. These inputs have de-
bounce circuits included. 

Sensor 
Mount for 
Rat Running 
Wheel
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If TR-3000 receivers are not being used (or if both auxiliary inputs are assigned to lick 
sensors or other units), a QA-4 Activity Input Module can be used to de-bounce the 
magnetic switch signal. 

In either case, an LED indicator next to the jack will light when the switch closes. Each QA-4 
Activity Input Module has four input jacks and its output cable is connected to one of six 
available inputs on a DP-24 Dataport. Therefore, one DP-24 Dataport equipped with six 
QA-4 Activity Input Modules can accommodate 24 magnetic switches from running wheels. 

1 Plug the cable from the magnetic sensor into either an auxiliary input jack on a TR-3000 
Receiver, or a jack on a QA-4 Activity Input Module. 

2 Verify that the power is turned on to the DP-24 Dataport. 

3 Rotate the running wheel and verify that the indicator LED flashes once (and only once) 
with each turn of the running wheel. 

For manual monitoring, magnetic running wheel switches can be connected to individual 
wheel counters. 
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Running wheel switch

Lick sensor

Running wheel switch

Lick sensor

QA-4

To DP-24

C-8 cable

Running wheel and
lick sensor cables are
2-conductor insolated

Connecting the QA-4 Activity Input Module
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DP-24

Feeding Monitor

Dual Input Module

C-8 cables

Connecting Feeding Monitors
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DP-24 #3

DP-24 #2

DP-24 #1

To computer

Red stripe
(Pin 1)

Note: When connecting DP-24s in series,
always connect with power applied to
the unit. This allows for proper initialization.

Connecting the DP-24 in Series
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Dual Input module will accept any input device that has two channels of data. 

DP-24

Dual Input
Modules

Feeding Monitor
(duration and frequency)

TR-3000
(activity and temperature)

Connecting the Dual Input Module
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DP-24 Input to DP-24
Channel 1 - Temperature (transmitter)
Channel 2 - Activity (transmitter)
Channel 3 - Running wheel
Channel 4 - Lick sensor

The DP-24 can accept up to six TR-3000
receivers, each carrying four channels of 
information for a total of 24 channels. The
system here is typical, but a variety of 
combinations is possible.

Connecting the TR-3000
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Computer

AC

ER-4 Power
Supply

ER-4 Power
Supply

Y-Cable Connector Set

ER Interlink Cables

Y-Cable Connector Set

NOTE: AC supply should include a UPS. 

Connecting the ER-4000 in Series
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APPENDIX

PRE-EXPERIMENT TEST 

Prior to running an experiment, it is recommended that you run a test of the system first. 
This will direct a performance check of the following: 

• Hardware connections are properly made 
• PC software is correctly installed 
• Animal and group setup is done properly 
• Calibration values are correctly entered 

• The hardware is connected, properly configured, and powered up according to 
Section 2. 

• The PC is properly set up according to Section 3. 
• A configuration file has either been loaded, or created, per Sections 4 and 5. 

This test will essentially “speed-test” your system, generate some data files for checking, and 
see that the system is operating as expected. 

1 From the VitalView Main window, click File and Start Data Collection. 

2 When prompted, click on Test. This selects an experimental test option. 

3 The ER-4000 Utility display will check for ER-4000 ID numbers. Follow the instructions. 

4 Click See ID Settings to verify that the Con settings are as intended. If correct, click List 
is OK. 

5 At the prompt, enter text that identifies the data collection session. 

6 At the file dialog, enter a filename. The extension will be .log, and will be appended 
automatically. Click OK when you have named the file. 

7 Follow the directions on the “System is Ready” window. 

8 Wait until VitalView is on-line. From the Main window, click on Data Collection Monitor. 

9 Click on a parameter panel to enter the Monitor Zoom display. Data should begin to 
stream from the right side of the chart. A value of -10 will indicate invalid or clipped data. 
Check the sample time information near the bottom of the display, and confirm. Exit back to 
the Main window. 

Introduction

Assumptions

Procedure

Steps 3 and 4 are 
only applicable 
if you are using 
ER-4000s in your 
system. 
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Leave VitalView on-line for a minimum of ten minutes. 

10 From the File menu, select Stop Data Collection. 

11 Click Data Load and Analysis. Click File. Click Load from VitalView Data File. 

12 Refer to “Data Load & Analysis” in Section 7 for the procedure to open the experiment 
log file of the data you just collected. 

13 Using the instructions in Section 7, check for the validity of data. 

If all of the data looks good, start data collection and begin the experiment. 
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APPENDIX

TRANSMITTER SAMPLING THEORY

E-Mitters and Transmitters 

E-Mitter transponders and battery powered transmitters (Mini-Mitters) use a thermistor 
to control an oscillator circuit whose frequency is related to thermistor temperature. 
The frequency, F, is a nonlinear function of temperature, T. The frequency of E-Mitters 
is approximately 800 Hz at 37º C. Battery-type transmitters have a characteristic 
oscillation frequency of about 400 Hz at 37º C. We can approximate the F(T) vs. T curve 
as an exponential. Equivalently, the logarithm of the frequency has a linear relationship to 
temperature as indicated in the following equation: 

ln(F)= β + αΤ 

When E-Mitters and Mini-Mitters are calibrated at the factory, the slope and intercept of this 
equation are determined with extremely high precision (approximately 0.1% uncertainty). 
This is accomplished by immersing each E-Mitter in a temperature-controlled water bath 
and scanning the temperature over a range of values. For each temperature point pulse, 
the oscillation frequency is measured. A mathematical algorithm is then used to derive the 
calibration values from the temperature data. These calibration values are the frequencies at 
37º C and 41º C. These values are recorded and provided to the customer with each device. 
Prior to data collection, these calibration frequencies must be entered into the system 
configuration through Animal & Group Setup. 

For E-Mitter devices only 

VitalView enables the user to provide either a two-point or a single-point calibration. When 
two points are used, the calibration frequencies for 37º C and for 41º C must be entered. 
Alternatively, when only a single calibration frequency is used, the calibration frequency 
corresponding to the 37º C point must be entered. If only the 37º C value is entered, 
VitalView will substitute a default value for the 41º C point. However, improved accuracy 
will be obtained when the calibration frequencies are entered for both the 37º C and 41º C 
points. Starr Life Sciences strongly recommends the two-point calibration set be used. 
Battery-type devices require a two-point calibration. 

Temperature Theory
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Introduction 

VitalView is a software and hardware system specifically designed for controlling data 
acquisition in laboratory monitoring of physiological parameters. VitalView consists of an 
application program known as VitalView and several types of acquisition hardware, including 
the Series 3000 transmitter/receiver systems, Series-4000 transponder/receiver systems, 
QA-4 activity input modules, and the DP-24 digital multiplexer. This note describes the data 
filtering schemes used for the Series-3000 and Series-4000 temperature and heart rate data 
acquisition systems. 

Series-3000 Systems 

A VitalView Series-3000 system consists of the VitalView program, a DP-24 digital 
multiplexer, one or more TR-3000 receivers, and a transmitter for each receiver. The 
VitalView Series-3000 system is capable of acquiring temperature data at a constant 
acquisition rate (number of samples per unit time). These data are sampled when the 
VitalView program sends a command to the DP-24 to send a current datum point. The rate 
of sampling can be adjusted from a minimum of once per second to a maximum of 20 times 
per second. 

In the Series-3000 system, as VitalView acquires individual temperature data points, they are 
stored in a first-in-first-out (FIFO) linear software buffer, whose size (length) is adjustable 
from a minimum of one (1) up to a maximum of 256 individual points. There is a buffer 
provided for each temperature data channel to be measured. As data acquisition begins, 
VitalView fetches each data point and retains it in the buffer until the buffer is completely 
filled. After that, each subsequent datum is placed in the buffer in the “last in” position, and 
the “first in” point is discarded, so that the length is preserved at the constant, set value. The 
default setting for the buffer length is 256. The operator can adjust the length to any value 
between 1 and 256 from within the System Setup window. 

The Series-3000 system software also filters the raw data using a threshold discriminating 
filter. In this filter, a running average and standard deviation are continuously calculated. All 
data points that are more than one standard deviation away from the mean are discarded. 

Individual data points stored in the VitalView Series-3000 buffers are not displayed, nor are 
they stored in the .log file by the VitalView application program. However, an average of 
these points is displayed and stored in the .log file. The rate at which this display and storage 
occurs is known as the sample interval and is adjustable within the VitalView Program 
Animal and Group Setup Window. The sample interval can be adjusted over a wide range 
starting from a minimum of one (1) second. When a parameter datum is to be displayed or 
stored, it is the average value of the total data within the buffer that is used. The average that 
is calculated is based on the buffered data just prior to the moment that the sample was 
requested. This datum, therefore, represents a moving average of a set of data points equal 
to the buffer length. 

In the Series-3000 system, it is possible to turn averaging off completely by reducing the 
buffer size to one (1). In this way, each datum that is fetched from the TR-3000 receiver 
represents the last temperature value that was measured. This is useful when the operator 
wishes to watch data being collected in an almost “real time” fashion. 

On-Line Filtering
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Series-4000 Systems 

A VitalView Series-4000 system consists of the VitalView program, at least one ER-4000 
receiver, and one transponder for each receiver. The Series-4000 system is capable of 
acquiring temperature and heart rate data at a constant acquisition rate of once per second. 
Within the ER-4000 receiver, data are averaged over many samples in a single averaging 
“bin”, but a weighting scheme is applied to accomplish time-averaging. This weighted scheme 
is represented in the following equation. 

Where, in this equation, N is the current datum, Last is the current sampled point, and M is 
the filter power. In this exponential filter, a particular datum is a weighted average of several 
previous data points, but the most recent data are given the greater emphasis. The default 
value of M is four (4), and it can be changed by the operator within System Setup. 

In addition to the exponential weighting average, the Series-4000 system hardware also 
filters the raw data using a threshold discriminating filter. In this filter, a running average 
and standard deviation are continuously calculated. All data points that are more than one 
standard deviation away from the mean are discarded. 

When using Series-4000 equipment with the VitalView program, the operator can, in 
addition to the exponential average, apply a boxcar average to sequential data points derived 
from the 1-second-sampled, exponentially-filtered data. Sequential data points can be 
accumulated into a software buffer whose minimum length is 2 and whose maximum length 
is 256. The system averages these data by adding up all the data in the buffer and dividing by 
the buffer length. In this scheme, a single datum is the result of having averaged the previous 
X data points, where X is between 2 and 256. The default setting for the buffer length is 120. 
The operator can adjust the length to any value between 2 and 256 from within the System 
Setup window. 

In the Series-4000 system, it is possible to turn averaging off almost completely by reducing 
the filter power to 2 and reducing the buffer size to 2. 

Data Validation 

When temperature and heart rate data are sensed, they are combined together and 
transmitted simultaneously to the receiver. It sometimes happens that when the animal 
moves, the temperature or heart rate transmission is momentarily interrupted. When this 
happens, the data just after the movement can be considered invalid or corrupted with 
movement artifacts. In both the Series-3000 and Series-4000 systems, the VitalView program 
performs continual data validation to reduce the occurrence of data artifacts. When data are 
accumulated in the buffers, each datum is compared to a running standard deviation of the 
data in the buffer. Data that are more than one standard deviation away from the mean are 
not counted in the average process. 

Activity data 

Both the Series-3000 and Series-4000 systems have the ability to register various types 
of activity counts. The Series-4000 system can measure movement activity, whereas the 
Series-3000 system can measure movement activity as well as other types of activity sensors 

AVGN = AVGN-1 + 
Last - AVGN-1

2M
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such as running wheel turns, feeding monitors, and lick sensors. In none of these cases is 
activity data filtered. Rather, the activity count datum is the total number of activity counts 
that have transpired since the last query was made. 

Summary 

Data averaging capabilities vary between the Series-3000 and Series-4000 VitalView systems. 
The Series-3000 system allows boxcar averaging on the accumulated data in the buffer. 
The Series-4000 system provides exponential filtering on raw data and also allows boxcar 
averaging on the accumulated data in the buffer. The Series-3000 and Series-4000 systems 
allow up to 256-time-bin averaging. In both systems, data validation provides a method to 
reduce the occurrence of artifacts in the data. To summarize the averaging features of both 
systems, the following table is useful. 

Averaging Parameter Series-3000 Series-4000
Sampling rate From 1 to 20 per second 1 per second

Sampling interval 1 second or greater 1 second or greater
Raw data averaging Boxcar Exponential + boxcar
Sample buffer length From 1 to 256 From 2 to 256
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Preparation for Implantation

APPENDIX

IMPLANTATION PROCEDURE

Introduction 

This manual describes the implantation of E-Mitters (PDT-4000), HR E-Mitters (PDT-4000 
HR), G2 E-Mitters, and G2 HR E-Mitters. 

The procedure for implantation of E-Mitters/G2 E-Mitters and HR/G2 HR E-Mitters is 
generally the same. The only difference is the surgical placement of HR E-Mitter heart rate 
leads, and a slightly different test procedure prior to closure. 

This manual assumes you have read the appropriate sections of the VitalView manual. This 
will give you a better understanding of the operation of the products. 

This section also assumes you are qualified in proper techniques including sterilization, 
anesthesia, surgery, recovery, and have the proper instruments. If you have questions 
concerning any of these procedures, call us at Starr Life Sciences Our technical staff will 
assist you. Make sure you are prepared for surgery well in advance. In addition to animal requirements, 
there are hardware and software preparations that must be made to the VitalView System. 

• You must have VitalView Version 2.20 or later.
• E-Mitters must be sterilized prior to implantation. Do not leave them immersed

longer than required for sterilization, but make sure they are sterile. Sterilization
techniques are covered in this section.

• Heart Rate E-Mitter leads may need advanced preparation. See “Preparing the Heart
Rate Leads” in this section.

• Depending on the species, it is often important not to feed the animal for 5 to 8
hours prior to surgery. For species specific information consult a veterinarian.

• A heating pad or other suitable heat source must be provided for the animal.
• Prepare a clean, disinfected work area with good lighting. Cold sterilants can be

utilized as well as sterile surgical draping to insure a sterile work area.
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Instruments and Materials Required 

• Anesthetic agent recommended for your study species.
• Hair clippers
• Betadine or other surgical scrub
• Zephiran, Alcide, or other liquid sterilant
• Furacin
• Adhesive tape
• Heating pad - for smaller species

• Scalpel handle (#3) and blade (#10)
• Surgical scissors (Metzenbaum)
• Toothed forceps (Adson)
• Suture materials such as stainless steel, silk, Vicryl®

• Suture needles
• Needle holder or straight six-inch heavy duty hemostat
• Mosquito hemostat
• Wound clips and applicator
• Gauze sponges and cotton-tipped applicators
• Stainless steel ferrules (if using heart rate E-Mitters)

An Implantation Kit is available from Starr Life Sciences. Call the factory for details. 

Surgical Information & References 

Starr Life Sciences E-Mitters can be implanted intraperitoneally or subcutaneously with a 
minimum of risk to the study animal, if common surgical guidelines are followed. Anesthesia 
and surgical procedures for each species will vary. In this section we have provided general 
information on preparation for surgery and a list of the surgical materials required. We 
recommend that VitalView system users consult with their local animal care professional 
and reference materials for specific guidelines. Explantation of E-Mitters will require the 
same advance preparation, anesthesia and surgical materials as implantation. 

Many references are available that may be of assistance in establishing animal care and use 
protocols: 

Guide to the Care and Use of Experimental Animals (ISBN 0-919087) 

Selection and Handling of Animals in Biomedical Research by Svendsen (ISBN 084934378X) 

The Laboratory Rat by Sharp and La Regina (ISBN 0-8493-2565-1) 

E-Mitters should be sterilized prior to surgery. Ethylene oxide gas and chemical sterilants 
such as activated glutaraldehyde (Cidex) and benzalconium chloride (Zephiran) can be used 
effectively. Avoid leaving the transmitters in chemical solution any longer than necessary. Be 
certain to properly aerate implants after gas sterilization. Rinse chemically sterilized implants 
in sterile saline just prior to implantation. 

CAUTION! Do not autoclave or exceed 60° C in gas sterilizers. Destruction of the E-Mitter may 
result. 

Sterilize the usual instruments including the lead placement trochar provided with your 

Non-Sterile 
Materials

Sterile 
Materials

Sterilants
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Heart Rate E-Mitters. This tool consists of a 1/8” diameter stainless steel rod and a close 
fitting sleeve.  It is used to create a tunnel under the skin and to pass the sensing lead to the 
proper location on the chest. 

If you are unfamiliar with lab animal anesthesia, you should consult an animal care 
professional or text references for information on recommended agents and dosages. 

Configuring the ER-4000 Prior to Surgery 
The VitalView system should be fully operational prior to implantation surgery. If possible, 
locate the system with an ER-4000 Energizer/Receiver near the surgery area so that subjects 
can be checked for a proper signal prior to closing. The configuration procedure is nearly 
identical for the E-Mitter, G2 E-Mitter, HR E-Mitter, and the G2 HR E-Mitter. All devices 
should be checked for proper communication with the ER-4000. The HR E-Mitter needs to 
be verified for heart rate signal. 

It will be necessary to use a valid configuration file for testing E-Mitter communication and 
data transfer. A configuration file called “Surgery” is included with the VitalView software 
package. If you do not have a configuration file, it will be necessary to make one. If you use 
an existing file, make sure the settings are changed to match the following configuration. 

1 From the Main window, click on Animal & Group Setup. 

2 In the Animal & Group Setup display, under Group menu, click on New. 

3 At the prompt, label this group appropriately, e.g. Surgery, etc. Click OK. 

Access: Main window > Animal & Group Setup > Group Menu > New

4 Click within any of the parameter panels. This will open the VitalView Animal 
Configuration display. Enter in the following values: 

Anesthesia
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NOTE: If you are using the standard E-Mitter or G2 E-Mitter, you do not need to enable Heart Rate. 

Note that the parameters are enabled, values entered, channels assigned, etc. Also note that 
the transmitter calibration values must be entered. This information can be obtained from 
the calibration sheet supplied with your E-Mitter. 

5 After all the values have been entered in the above display, click on OK. 

6 Under the File menu, choose Save Configuration, and save this file as “Test E-Mitter”, 
“Surgery”, or some other appropriate name. Exit to the Main VitalView window. 

7 Make sure the ER-4000 is connected and operating (red LED is illuminated). Under File 
from the Main Window, click on Start Data Collection, and follow the prompts. 

NOTE: It is advantageous to have the ER-4000 operational or near-operational prior to surgery so a 
minimum number of steps is nec essary to monitor the E-Mitter signal. 

Introduction 
The implant procedure for E-Mitters is not difficult for those with basic surgical experience 
on laboratory animals. It is recommended that individuals review these procedures carefully 
prior to surgery. 

The E-Mitter is a very reliable product. However, it is recommended that the unit be 
checked prior to surgery. This will assure you that the E-Mitter and ER-4000 are operational. 

NOTE: The G2 E-Mitter is a miniaturized version of the standard temperature and activity E-Mitter. The 
implantation procedure as well as functionality is identical. 

Preparation of the Implant 
E-Mitters should be sterilized and kept warm prior to surgery. 

The use of sterile technique, including sterile instruments, a drape, and gloves must be 
employed. E-Mitters offer an implant life surpassing that of the animal, so it is important not 
to compromise this advantage by the risk of infection. 

General Implantation Preparation
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Animal Preparation 
1 Anesthetize the animal prior to preparation. Depth of anesthesia may be ascertained by 

using the pedal reflex technique. Pinch the toe of the animal. The lack of a withdrawal 
reaction means the depth of anesthesia is adequate. 

2 Shave the ventral surface of the abdomen for both E-Mitter and HR E-Mitter devices 
(dark gray area). If implanting HR E-Mitters, shave the thorax to the area of the axilla, 
slightly cranial on the right side (light gray areas illustrated below). 

3 Scrub the shaved area with Betadine or other surgical scrub. 

4 Secure the animal to a sterile surgical surface with adhesive tape. Make sure the surgical 
surface is heated. 

CAUTION! For smaller species, a heating pad or other device is mandatory. Keeping the animal 
warm is essential for prompt and thorough recovery. 
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1 Make a midline abdominal skin incision 1 cm below the diaphragm, and no more than 2 
cm in length. 

2 Open the abdomen by making a 2 cm incision along the linea abla (the “white line” of 
fascia where the abdominal muscles join on the midline). 

CAUTION! Take care not to cut the bowel. As the skin incision is made, the abdominal muscles tend 
to relax, resulting in the bowel being immediately under the surface. 

E-Mitter Implantation Technique
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3 Positioning of the E-Mitter in the abdominal cavity is important to acquire accurate 
temperature data. If it is too close to the surface of the skin, it may be affected by room 
temperature. 

4 Gently reflect the intestines and colon. Slip the body of the E-Mitter into the abdominal 
cavity along the sagittal plane, placing it in front of the caudal arteries and veins, but 
dorsal to the digestive organs. 

Experience has shown that in some cases, the PDT4000 E-Mitter may migrate within an 
animal. The migration may allow excursions of temperature data. For example, if the E-Mitter 
migrates near the outside of the peritoneal cavity and the animal lies down on a cold cage 
surface, the temperature may register lower than the actual core temperature. 

In order to reduce migration of the E-Mitter a silastic sleeve has been attached to the 
surface (illustration is exaggerated). This sleeve is designed to be used as an anchor point 
through which suture material may be passed. Its use is recommended for all temperature 
monitoring applications. 

These instructions only apply to the PDT4000 and G2 transponder. The PDT4000HR and 
G2 HR do not require this additional implantation step. 

Silastic 
Suture Sleeve 
Procedure
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Standard E-Mitter shown

5 Pass suture material through the silastic tubing that is attached to the outer wall of the 
E-Mitter capsule.

6 Suture the capsule to the body wall.

 Making use of the sleeve to anchor the E-Mitter to the body wall will reduce the 
likelihood of hte E-Mitter moving freely within the peritoneal cavity. This may also 
decrease the need of the ER-4000 Energizer/Receiver to re-acquire a signal lock from 
the implanted transponder.

7 Replace the organs, effectively “burying” the E-Mitter.

8 Massage and lightly jostle the abdominal cavity to allow the internal organs to settle. 
Examine the small intestine and colon for kinks.

9 If you wish to check for data prior to closure, place the animal on the ER-4000. Check 
for a green LED, confirming signal lock. If there is no green LED, move the animal to a 

Implantation 
Using the 
Silastic Sleeve
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different spot on the ER-4000, or raise the animal slightly above the receiver surface. A 
green LED assures that a signal is being received. 

10 From the Main window, click on Data Collection Monitor.  You should see data coming 
from the activity and temperature channels. Remove the animal. 

11 Place simple interrupted absorbable sutures as needed to close the abdominal incision. 
See “Closure” in this Section for typical closure procedure. 

The VitalView system should be fully operational prior to beginning surgery. See the 
Hardware Installation section of the VitalView manual for installation details. 

You will place the animal on the ER-4000 during surgery so that proper heart rate signal can 
be checked prior to closing. Remember to put a heating pad between the receiver and the 
animal. A simple household heating pad should not interfere with the signal. 

It will be necessary to use a valid configuration file for testing the E-Mitter. If you do not 
have a configuration file, it will be necessary to make one. Follow the directions in the 
E-Mitter section.  If you use an existing file, make sure the settings are appropriate for 
monitoring the heart rate signal. 

NOTE: The heart rate leads will need preparation prior to surgery. See “Preparing the Heart Rate Leads.”  

Lead preparation is important. The electrode leads must be cut to length to position them 
near the heart in a specific plane. To assist in fixation, a small tab is attached to the end 
of the heart rate lead. This tab also prevents the sharp electrode from injuring the animal. 
Proper lead preparation also assures good contact with the chest muscle. 

CAUTION! It is very important that the two electrode lead wires be placed subcutaneously on the 
chest wall at a 45-60 degree angle relative to the transverse plane of the heart. Improper lead 
place ment will result in low signal pickup and unreliable heart rate detection. Rectifying this problem 
will require another surgical pro cedure. 

CAUTION! Do not pull on the leads. Although the lead attachment has been designed to withstand 
considerable tension, the leads can become detached from the header elements. 

NOTE: If implanting an explanted HR or G2 HR E-Mitter, make sure the leads are thoroughly cleaned of 
all organic artifacts. Lack of cleaning may cause degradation of the heart rate signal, particularly during 
pre-testing. 

HR E-Mitter Implantation Preparation
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Proper placement allows the voltage created by the R wave of the QRS complex (a phase of 
the cardiac electrical cycle) to trigger a pulse detected by the ER-4000 Energizer/Receiver. 
The heart rate is then reported by the VitalView system as a beats-per-minute value based 
on a computation from the R-R interval. 

Preparing the Heart Rate Leads 
For proper heart rate detection the sensor lead length must be taken into account. To 
accommodate size differences in animals, the following procedure may be used to shorten 
lead length. 

NOTE: If the leads are too short, heart rate detection may be impaired. If the leads are too long, the 
spring action of the leads may push the HR E-Mitter to the bottom of the abdomen. 

Be certain to allow 1 to 2 cm of excess lead wire to act as a strain relief for animal 
movement. Excess lead wire should be left under the skin in an ‘S’ curve where the leads 
exit the abdominal cavity. This allows for growth and flexing of the body from side to side. 
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NOTE: The following are approximate lengths of the HR E-Mitter leads measured from E-Mitter 
body to end of lead before attach ment. Animals sizes vary greatly; careful measurement is highly 
recommended. 

Mice Rats
Negative lead 
(longer, black)

35 mm 75 mm

Positive lead
(shorter, clear)

20 mm 45 mm

The negative lead (black) is directed to the anterior right (animal’s right) side of the chest 
wall near the clavicle. It is the longest lead. 

The positive lead (clear) is placed on the posterior chest wall to the left of the sternum 
and anterior to the last rib. It is the shorter of the two leads. 

NOTE: The tubing acts as an insulator, and must be left in place as shown in the next illustration. 
Removing too much of the tubing may result in a low signal from the heart. 

To prepare the leads, use the following procedure. 

1 Place the HR E-Mitter on the abdomen midline of the subject as in the previous 
illustration. Direct the leads to the implant sites, and then mark the lead for proper 
length. 

2 mmHelical coil

Tubing

2 Leads should be cut cleanly across with small, sharp wire cutters or sturdy scissors. 
Again, be certain to leave some excess lead length to allow for growth and body 
movement. 

3 Using a scalpel blade cut around the lead to aid in removing the insulation. Strip 2 mm of 
tubing from the tip of the lead to bare the helical coil inside. Pull the coating off, leaving 
the tip section bare. Be certain not to nick or cut through the coil wire. The leads are 
now prepared for implantation. 

Monitoring the HR E-Mitter heart rate signal 
1 From the Main window File menu, choose Open Configuration File. Highlight the 

E-Mitter test file previously saved from “Configuring the ER-4000 Prior to Surgery,” or 
your own configuration file. Click OK. 

2 From the Main window, click on System Setup. 
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3  In the ER-4000 Configuration panel, click on Utility. Follow the prompts and wait for the 
ER-4000 to initialize. 

After the ER-4000 initializes, click on Heart Signal Monitor. Your system is ready to monitor 
signals from the Heart Rate E-Mitter. You may leave it in this mode during surgery to test the 
E-Mitter prior to closing. 

If you have any questions, refer to the System Setup section of the VitalView manual. 

Animal Preparation 
See the previous “Animal Preparation” section. 

HR E-Mitter Implantation Technique 
1 Make a midline abdominal skin incision 1 cm below the diaphragm, and no more than 2 

cm in length. 
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2 Open the abdomen by making a 2 cm incision along the linea alba (the ‘white line’ of 
fascia where the abdominal muscles join on the midline). 

CAUTION! Take care not to cut the bowel. As the skin incision is made, the abdominal muscles tend 
to relax, which results in the bowel being immediately under the surface.
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3 Positioning of the HR E-Mitter in the abdominal cavity is important to acquire accurate 
temperature data. If it is too close to the surface of the skin, it may be affected by room 
temperature. 

Gently reflect the intestines and colon. Slip the body of the HR E-Mitter into the abdominal 
cavity along the sagittal plane (with the lead wires facing toward the animal’s head), placing 
it in front of the caudal arteries and veins, but dorsal to the digestive organs. Replace the 
organs, effectively “burying” the “rear” portion of the HR E-Mitter (without the leads). This is 
the portion of the HR E-Mitter that contains the temperature sensor. 

4 Bring both leads out of the abdominal incision as shown below. The negative (black) 
lead should be on the animal’s right; the positive (shorter - clear) lead should be on the 
animal’s left. 

5 Massage and lightly jostle the abdominal cavity to allow the internal organs to settle. 
Examine the small intestine and colon for kinks. 
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6 With a small mosquito hemostat, bluntly make a small hole through the abdominal wall 
(external oblique). This hole should be to the right of the incision (see below). Push the 
positive lead from the abdominal cavity through this hole. 
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7 On the other side of the abdominal incision, make a similar hole through the abdominal 
wall (as was made in step 4). Push the positive lead from the abdominal cavity through 
this hole. 

8 At this time, to prevent tissue necrosis, close the abdominal wall with 5-0 absorbable 
suture material, using a continuous interlocking mattress stitch. 

NOTE: For clarity of polarization, the following illustrations do not show the abdomen closed. 
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Negative Lead Attachment 
1 Make a small incision (0.5 cm) in the skin near the clavicle. Make sure the two-part lead 

insertion tool (trochar) consisting of sleeve and probe, is assembled. Push the trochar 
through the hole in the skin. Push the tool subcutaneously until it reaches the area of the 
lead. Pull the inside probe out of the trochar sleeve. 

NOTE: When placing the leads in small animals, it may be possible to insert a hemostat in the incision 
and “tease” under the skin and pull the lead through subcutaneously. 
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2 Push the entire lead through the trochar sleeve. When the lead is completely inserted 
into the sleeve, remove the sleeve. The lead will remain in place between the skin and 
muscle wall. The end of the lead should be near the clavicle, and resting on the pectoralis 
superficialis. 

3 Slip a metal ferrule over the tip of the lead, and crimp into a “tab” with a non-serrated 
pliers (or needle holder) (see detail below). 

Lead Tip

NOTE: In the following procedure, placing the lead in the thin layer of subcutaneous tissue will NOT 
provide adequate contact for a reliable heart rate signal. It must be held fast against muscle tissue with 
metal suture material. 
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4 With metal suture material (000 or 34 gauge), place a small lock stitch at the top of the 
pectoralis superficialis, located near the clavicle. Take a rather large “bite”, leaving a loop 
approximately 2 mm in diameter. Tighten the knot, but DO NOT TIGHTEN the loop 
that is through the muscle. 

CAUTION! You are very near the subclavian artery and vein. Punc turing will likely cause an instant 
fatal hemorrhage. 

5 Place a length of suture material around the lead tip just behind the tab and complete 
the second throw of the suture knot to hold the lead tip firmly in place. Trim the excess. 

Muscle tissue

After the lock stitch is tied, 
suture is placed under the 
tab and secured with 
another square knot.
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Positive Lead Placement 
1 Make a small incision (0.5 cm) to the left of the xiphoid process and cranial to the last 

rib. 
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2 You may use the trochar to place the positive lead using the same technique as the 
negative lead, or use a mosquito hemostat to tease it into place. (If you choose not to 
use the trochar, it may be more convenient to attach the metal ferrule now as described 
in step 3.) Work the muscle wall away from the skin, and push the heart rate lead 
between the skin and muscle. Keep the lead as flat as possible. 

3 Attach a metal ferrule using the same procedure as the negative lead. 

4 Secure the lead against a chest muscle (cutaneus trunci, pectoralis profundus, posterior 
pectoralis superficialis, etc.) in the same manner as the negative lead, attaching the suture 
just behind the tab. 

Fasten positive heart rate lead
to muscle wall near diaphragm.



120

Confirming the Implant 
1 At this time, check the heart rate signal. Place the animal on the ER 4000 with VitalView 

operational and in Heart Signal Monitor mode. Check the strength of the signal. It 
 should be 1 ½ to 2 vertical grids in amplitude. If lower than this, reorient the subject on 

the ER-4000. 

Access: Main window > System Setup > Utility > Heart Signal

2 If no improvment, the lead placement may need to be changed. Reposition the leads 
slightly. Check to see if the leads were placed in superficial connective tissue. If they 
were, dissect through the connective tissue and take a bigger “bite” into the chest 
muscle tissue when placing the anchoring sutures. 
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Closure 
1 Close the smaller two-lead access points with 34-gauge stainless steel suture material. 

2 Close the abdominal opening with 5-0 Vicryl® absorbable suture material using a 
continuous interlocking running stitch. 

3 Close the skin with 34-gauge stainless steel suture material using interrupted mattress 
stitches. 

4 Clean the skin surface with Betadine solution, and puff on a little Furacin powder. 

CAUTION! During the animal’s recovery period, pay particular attention to the temperature of the 
cage and surrounding environment. A lamp, cage heater, or heating pad may be used until the ani-
mal is fully ambulatory. Remember, the animal is now carrying more non-biological mass that must 
be heated during this recovery period. 

Allow the animals to recover, and place them in their home cages positioned on top of the 
ER-4000 Energizer/Receivers. 

The heart rate signal may be intermittent at times during the anesthesia recovery phase 
when the animals are hyperactive and uncoordinated in their movements. 

Signal quality will generally improve within 2 to 3 days post-operatively as fibrous connective 
tissue forms around the lead tips. 
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APPENDIX

DATA FILTERING 

The data that have been collected with VitalView may require additional processing in order 
to be included in a final research report. For example, the sampling interval may need to be 
changed, and out of range data replaced. This is the purpose of the data filter. 

Filters are mathematical manipulations of a data set which function to change the scale, 
offset, or perform averaging or smoothing to remove artifacts. Often this will result in the 
uncovering of a useful pattern or trend. These processed data sets may then be exported as 
ASCII files for use in statistical programs, spreadsheets, or graphics packages. 

NOTE: The data filters available in VitalView do not change the original VitalView data files. Only data 
loaded in the Analysis Buffers are altered. If you have applied a filter and want to save the manipulated 
data set, you may do so as an ASCII file for later load ing into other programs. 

We suggest that data filters be applied prior to employing statistical routines or calculating 
group means. For example, removing the -10 values that may have been placed in the data by 
VitalView when the clipping limits have been exceeded, will make a difference in the results 
of a “t” test analysis. 

Available Filters 

This filter will replace any invalid or missing data point with the value of the last valid data 
sample previous to the invalid or missing point. Before applying the Invalid Points filter, a 
message will appear listing the criteria for its use. This statement should be read carefully. 

This filter averages a user-determined number of data points to produce a new data value. 
This is also known as bin or bucket average, or windowing. This type of data filter is often 
used to reduce the impact of spurious data on further statistical analysis. This also can 
be used to collapse a data set containing a large number of points into a smaller one. No 
weighting scheme is applied to data points as they are averaged. 

For this filter the value entered in the Analysis Filters display refers to the number of points 
that are averaged together to produce one average value in the resulting data set. 

When the decimation function is activated, an explanatory message appears which contains 
the following information: 

Invalid Points

Decimation
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SPECIAL INSTRUCTIONS: If you have selected to decimate less than the full 
number of currently loaded data channels, please be aware that the Save To ASCII File 
function is not fully compatible with this. 

The Save To ASCII File function expects all channels to have the same number of data 
samples and the same time interval between data samples. Applying decimation to 
only some of the channels, or applying a different decimation value to some and not 
others, violates this condition. 

For best ASCII file results, select all currently loaded data arrays so that all channels 
are decimated equally. 

If you decimate only some of the channels that are loaded, note that: 
• The ASCII file produced by VitalView will report an incorrect End Date/Time for the 

data set. 
• Those channels with larger post-decimation sampling intervals will be listed in the 

ASCII file at the right of those channels with shorter sampling intervals. 
• The data columns for those channels with larger post-decimation sampling intervals 

may show data that are time-stamped with times that are greater than the true End 
Date/Time for the data set. Such data in these columns should be ignored (it is the 
original “raw” data from prior to the decimation). 

It may be inappropriate to decimate all channels that are loaded. In this case, it is best to re-
load, selecting to load only those channels that can appropriately have the same decimation 
value applied to them before using the Save to ASCII function. 

NOTE: Decimation produces an average value for the number of points entered in the value field. If you 
wish to accumulate a sum of all counts rather than an average, also select the scale and set it to the 
same value as the decimation. This will produce a sum over the period. This technique is appropriate for 
activity parameters like running wheel turns, or licks, but not for variables like temperature or heart rate. 

Multiplies each data value by the scaling factor entered. This can be used to change the 
vertical resolution of the data chart. 

For this filter, the value entered in the Analysis Filters display refers to the scaling factor by 
which every data value will be multiplied. The data after the scale operation equals data at 
scale 1 multiplied by the new scale factor entered. 

Adds the entered offset value to each data point in a data set. This is useful if a baseline value 
has changed during the course of an experiment. 

For this filter, the value entered refers to a number which, if positive, will be added to each 
data point, if negative, will be subtracted from each data point. Adds or subtracts from the 
original data. It is not cumulative. 

Converts the Y-Axis to a logarithmic scale. This operation cannot be reversed. You must 
reload the data to view the original values. 

This data filter is intended to remove non-physiological values from the data set. This filter 
will replace any data that are outside the clipping limits. The replacement that occurs is an 

Scale

Clipping

Offset

Log 10
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interpolated straight line between points that are within the clipping limits and that bound 
the subset of data that are outside the clipping limits. Use with caution on activity and wheel 
turn data. 

This data filter enhances or emphasizes the sleep/wake patterns in activity data from ER-
4000 receivers. This is done first by clipping, then smoothing the high-sensitivity data. The 
smoothing is accomplished by passing an averaging window across the data. 

When using this filter, the Filter Window (see the illustration “Data files analysis display”) 
may be adjusted for various amounts of data. The 1.000 hour default setting will usually 
suffice. Care must be taken when adjusting this setting. Less than one hour and the filter may 
not have any significant effect. More than one hour, and the filter may smooth the data too 
much, in addition to requiring a long processing time. 

Processing time may be quite long. This time can be reduced by doing the following: 
• Select fewer channels when in the Analysis Filters window. 
• Load less data. Select less than the full collection time. 
• Select a smaller filter window in the Analysis Filters window. 
• Apply the decimate operation (see “Decimation”) to reduce the time between 

points. 

Consider selecting a single channel with about five days of data loaded, and experiment with 
the filter window size before processing all the channels and all the data. 

Applying Data Filters 

All data sets that are currently loaded in VitalView Analysis may have filters applied to them. 
This may be done as a batch process with several filters applied. However, we recommend 
they be done singly until familiarity is gained with the effects of each filter. The order of 
application is fixed by the program when multiple operations are selected, and the order of 
application can make a difference to the final output in some cases. 

The following is an example of applying a filter to data. This uses the ER 4000 Activity Filter 
as an example. The same process applies to other filters as well. 

1 Using Data Load and Analysis from the Main display, load in the subject files (see details 
in “Data Load & Analysis” in Section 7). Hold down the shift key and click to choose 
multiple selections. Progress will be noted in a pop-up prompt. 

Main display > Data Load and Analysis > (file of choice) 

ER-4000 
Activity Filter
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2 Once the file is loaded, click on Four Plot Stack to see the original, unfiltered data. 
Data files analysis display 

Unfiltered data 

3 To filter the data, click on Exit, and return to the original Data Analysis display. 

4 From the Analysis menu, choose Filter Data. The window (below) will show the filter 
choices available and the files that are currently loaded. In this case, ER-4000 Activity 
Filter is chosen, and the files of interest are highlighted. Click on Apply Selected 
Operation(s). 

NOTE: Multiple filter choices may be made. 

Analysis > Filter Data 

5 The following Four Plot Stack Graph shows the results of the ER-4000 Activity Filter. The 
filter data shown below may be compared with the unfiltered data displayed above. 



126

ER-4000 Activity Filtering

Data may be passed through a filter multiple times, with a variety of filters applied to the 
data. 

Order of Application 

When more than one of the data filters is selected, VitalView will apply them in the order 
listed below: 

• Invalid points 
• Clipping 
• Scale 
• Offset 
• Decimate 
• Log 10 
• ER-4000 Activity Filter 

For information on saving filtered files so they may be used in other applications, such as 
Excel or Actiview, see Section 7. 
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APPENDIX 

STARTING A SEAMLESS 
SECOND SESSION 

If data collection has been stopped, either accidentally or by a need to change the 
configuration, this procedure should be used to restart the data collection. 

If you have changed configurations 

If a parameter is added or deleted, or if the sampling interval of any parameter is changed, 
the files from before and after the configuration change will not join properly into a 
contiguous data set. This will result in an experiment represented by at least two different 
sets of files. The number of parameters and the sampling interval for each parameter must 
remain the same for sessions to properly join. 

The following procedure should be used when restarting VitalView. 

1 Save any configuration files that were made. 

2 From the Main window File menu, click Exit VitalView, and wait for VitalView to shut 
down. 

3 When ready to start VitalView again. Use Start > Programs > VitalView > Vitalview.exe. 

4 When the Main window appears, choose the File menu, and select Open Configuration 
File. 

5 Click Load. 

6 Navigate to the folder that holds the files for the previous session, select and open the 
configuration file for that session. 

7 Click Yes to review the Animal & Group Sampling Configuration and confirm this is the 
correct configuration. 

NOTE: Although some changes may be made to this file, the number of parameters and the sampling 
interval must be the same across both sessions to properly join. 

Before Continuing

Procedure
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8 Click Exit to return to the Main window. 

9 Under the File menu select Start Data Collection, and click on Standard. 

10 If ER-4000 receivers are included in the system, VitalView will communicate with each 
one and list all receivers that were identified. Verify that all receivers in the chain have 
been identified and are listed. When you are sure that all ER-4000s are listed correctly, 
click on List is OK. 

11 When prompted, enter a text comment, e.g. Experiment B, Session 2, relating to the 
experiment description, and click OK. (This name will appear in several displays, such as 
the head of the ASCII file data outputs, etc). 

12 At the File dialog, use the “Up One Level” and ”Open” buttons as necessary to navigate 
to the folder containing the experiment log file and data files of the previous session. 
Select the log file for the previous session, edit the name slightly to denote it from the 
previous session, then click the Save button. 

13 If you are not already thoroughly confident that VitalView is configured correctly, confirm 
the current configuration is as    intended by using the buttons provided in the lower 
right of the “System is ready” display (not including the Data Load button, which has a 
different purpose - see step 15). 

14 Confirm the date and time reported by the “System is ready” window are correct. If 
they are not, you probably do not want to reset them unless they are wildly inaccurate. 
If you reset your PC clock, then the pace of data collection between this session and 
the previous session will likely be broken. Depending on the nature of your research, 
it may be better to have incorrect timestamps on the data (all with the same offset to 
the correct time) than to have a pace breaking time offset between this session and the 
previous session. To reset your PC clock, refer to “To start data collection” in Section 6, 
beginning with step 9. 

15 If you started the previous session as recommended at a Pre-set Time that was “on the 
hour” or that was “a whole increment of the sampling interval after the hour” (i.e., by 
clicking the “Set to next hour” or “Set Pre-set Time” buttons), then do this again for this 
session. 

You may find it helpful to review step 9 under “Subsequent session” in Section 6. 

NOTE: If you did not start the previous session at a recommended Pre-set Time, and you must have the 
pace of data collection pre served from the previous session across and through this session, click the 
Data Load button on the “System is ready” window. Read and follow the directions given in the message 
that pops up. 

16 With the correct Pre-set Time set, click on “Start Collection at Pre-set Time”. A 
“countdown” window will appear and stay on the display until the PC clock catches up 
to the Pre-set Time from step 15. 

17 When the PC clock passes the Pre-set Time, VitalView will go on-line and begin 
collecting data, as indicated by the green flashing indicator in the Main window. If 
your sampling interval is short, you may confirm the readings for all parameters are 
reasonable. Use the Data Collection Monitor from the Main window. (See “Data 
Collection Monitor Display” in Section 6). 
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APPENDIX 

JOINING FILES 

Files from two or more data collection sessions can be joined. 

If a parameter is added or deleted, or if the sampling interval of any parameter is changed, 
the files from before and after the configuration change will not join properly into a 
contiguous data set. This will result in an experiment represented by at least two different 
sets of files. The number of parameters and the sampling interval for each parameter must 
remain the same for sessions to properly join. 

In the following example, the data from three experiments will be joined into one 
contiguous file. 

The three folders of data should look similar to the following: 

ratslp1.cfg .....the main configuration file (1st session of experiment)

ratslp1.cal .....supplementary configuration file holding temperature calibration values

ratslp1.evn .....supplementary configuration file holding event schedules (and links)

ratslp1.log .....the log file for the experiment (a list of data files)

ratslp1.001 .....the first data file

ratslp1.002 .....the second data file

ratslp1.003 .....the third data file

ratslp2.cfg .....the main configuration file (2nd session of experiment)

ratslp2.cal .....supplementary configuration file holding temperature calibration values

ratslp2.evn .....supplementary configuration file holding event schedules (and links)

ratslp2.log .....the log file for the experiment (a list of data files)

ratslp2.001 .....the first data file

ratslp2.002 .....the second data file

ratslp3.cfg .....the main configuration file (3rd session of experiment)

ratslp3.cal .....supplementary configuration file holding temperature calibration values

ratslp3.evn .....supplementary configuration file holding event schedules (and links)

ratslp3.log .....the log file for the experiment (a list of data files)

ratslp3.001 .....the first data file

ratslp3.002 .....the second data file
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In the previous example, three data files were collected in the first session, and two data 
files were collected in each of the second and third sessions. 

In order to join these sessions, it is necessary to rename the data files of the second and 
third sessions as follows: 

ratslp2.001 to ratslp1.004
ratslp2.002 to ratslp1.005
ratslp3.001 to ratslp1.006
ratslp3.002 to ratslp1.007

This results in the following file set for the full experiment: 

ratslp1.cfg .....the main configuration file with Animal & Group and System Setu

ratslp1.cal .....supplementary configuration file holding temperature calibration values

ratslp1.evn .....supplementary configuration file holding event schedules (and links

ratslp1.log  .....the log file for the experiment (a list of data files) 

ratslp1.001  .....the first data file

ratslp1.002 .....the second data file

ratslp1.003 .....the third data file

ratslp1.004 ....the fourth data file

ratslp1.005 .....the fifth data file 

ratslp1.006  .....the sixth data file 

ratslp1.007  .....the seventh data file 

If the ratslip1.log file is loaded into VitalView, only the first three data files will load. This is 
because the ratslp1.log file lists only those three files. The log file must be updated to include 
all seven files. 

To update the log file, run the Restore VitalView Log File function from the Data Load & 
Analysis File menu. The log file will list all seven files, the data from all seven files, and all 
three sessions. 

• At the Choose Logfile to Restore dialog, the log file that must be selected is ratslp1.
log. 

• Click on save. 
• Replace 
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APPENDIX

TROUBLESHOOTING

This appendix is written with a decision tree format. The problems are divided into those 
dealing with data acquisition and those associated with data analysis. The most basic 
problems are covered first, followed by more complex ones. Find your symptom and go 
from there until you find the solution. If, after trying the suggestions in this section, you are 
still unable to solve your problem, do not hesitate to contact Starr Life Sciences Technical 
Support.  We will work with you to understand your problem and provide the solution to 
it.

Introduction

Problem Symptom Procedure
System tries 
to go on-line, 
but fails during 
initialization of 
ER-4000s

Blank list of receivers 
in ER-4000 utility 
panel.

Be sure Y-cable connector from the ER-4000 series is connected to the 
proper COM port identified in the software. To verify which COM ports 
your computer has installed: Start > Settings > Control Panel > System > 
Device Manager tab > click +next to Ports.

Check power to the ER-4000s. Red lights should be blinking twice per 
second. Check power strip, outlet, UPS. Too many ER-4000s per supply 
(maximum 4)? Everything plugged in?
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Problem Symptom Procedure
Green on-line 
indicator flashing 
in VitalView 
Window, but not 
data.

-10 on all channels TR-3000 System
Are the DP-24s powered up? Are the green lights on? If not, check power 
to devices. Check that DP-24s are connected to the computer. Check C-50 
cables. Check DP-24 IDs. Be sure to connect the power supply to the 
DP-24 before connecting the C-50 cables. This will ensure proper 
initialization.

Are the TR-3000s receiving power? Test by moving a transmitter within 
range while watching the activity indicator. It should blink when activity 
is detected. If not, there is likely a power problem. Check the C-8 cable 
connections.

If there are QA-4s, check for power. Close the switch (rotate running 
wheel, touch lick sensor, etc.). The red light should indicated a switch 
closure.

The most common cause of no data is faulty hardware setup. Verify power 
and communication cabling.
ER-4000 System
Is E-Mitter within range of ER-4000? If VitalView is on-line and the ER-4000 
detects a working E-Mitter, the green LED will light. If the animal moves, 
the green light will go out momentarily, but should re-ligh within 2 to 3 
seconds depending on animal movement. If the green light does not light, 
move cage to center the animal over the ER-4000. Does the green light 
stay out? There may be a problem with the E-Mitter or the ER-4000. Try a 
E-Mitter or ER-4000 to verify which is at fault.
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Problem Symptom Procedure
Inconsistent data 
on channels

Excessively high 
temperature data on 
some channels.

High values are usually the result of some type of interference, including 
another E-Mitter close by (minimum 20 cm spacing). Check by moving 
adjacent animals further away from affected animal and watch for 
correct temperature data.

Check for EMI from electronic motors, mass spectrometers, diathermy 
machines, MRI devices, etc. Listen for interference with a small AM radio 
set for 500 KHz. Place radio near TR-3000. If static is heard, move the radio 
around to find the source.

Check cable routing. EMI may be picked up by interaction of system cabling. 
Route C-8 and C-50 cables away from power cords, telephone cables, etc. 
As in previous procedure, use an AM radio to find the source of noise. 
Route cables away from each other. When signal cables must cross power 
cables, cross them at a 90° angle.

Low or no 
temperature values.

May be the result of poor signal pickup by the receiver because a 
fraction of the pulses are being detected. The cage may be too large for 
the E-Mitter implanted in the animal. 

The receiver may have Range Adjustment set too low, effectively 
reducing the range. Before adjusting, contact Starr Life Sciences Technical 
Support for directions.

This symptom may also be the result of a low battery, poor 
battery contact, or damaged E-Mitter.

Unusually high activity 
data. (For example, 
several thousand 
counts in a five 
minute period.)

Usually the result of noise. Look for cales running close to computers, DP-
24 and ER-4000 power supplies, and other sources. DP-24 DataPorts are 
very sensitive to external noise through their input cables.

PC performance 
is suspect

Unusual crashes or 
“hangs.” Memory 
limitation warnings.

Check “Computing Platform” in Section 1 to ensure you have enough 
computing power, hard disk space, RAM, and other platform characteristics.

To prevent application conflicts, see that no programs are running other 
than VitalView.

Make sure the virtual memory is set to approximately 2.5 times the 
amount of actaul RAM. Consult your system documentation for this 
procedure.

Disk write error Computer error 
message. VitalView 
error message. In 
Data Collection 
Monitor, disk write 
error YES indicator 
will be yellow.

Exit Data Collection Monitor back to the Main Window. This will reset the 
error indicator from YES to NO. Enter the Data Collection Monitor again. 
If the error repeats (YES indicator), run ScanDisk’s Thorough setting. If 
ScanDisk reports OK, open VitalView and begin collecting data again. For 
further information on restarting, see “Starting a Seamless Second Session” 
in Appendix G, and “Joining Files” in Appendix H.

Crash Recovery “Has there been 
a power failure?” 
indicator in Data 
Collection Monitor 
turns to yellow.

See note on following page.
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A “Crash Recovery” (or power failure) is a programmed process the PC executes after 
power comes back following a power loss while VitalView was on-line. A crash recovery 
will also take place after something causes the VitalView program to abort execution (such 
as Ctrl+Alt+Delete is entered, and Shutdown or End Task is selected). If the PC is powered 
through a UPS, and the power comes back before the UPS’s batteries have discharged, there 
is much less need for the crash recovery process. However, to cover the unlikely event of a 
PC hardware or software error that causes a program to abort, it is recommended to set 
up the PC to take advantage of VitalView’s automatic crash recovery feature. 

After crash recovery, the “Has there been a power failure?” indicator at the top of the Data 
Collection Monitor will be a yellow “Yes.” 

Verify if good data are being collected for all parameters (wait a number of sampling 
intervals before evaluating). If data are OK for all parameters, then let VitalView continue. 
The crash recovery process should have maintained the pacing of the data collection. For 
example, if the initial start time was 9:30, and the sampling interval is 10 minutes, samples 
should still be reporting in the VitalView Monitor Zoom display at 0, 10, 20, 30, 40, or 
50 minutes after the hour. If the system shows any sign that the PC or VitalView did not 
recover, see Appendix G. 

To clear the “Has there been a power failure?” indicator, exit the Data Collection Monitor 
to the Main window, and click the Data Collection Monitor button. The indicator will have 
changed to “No.” 

Sometimes portions of hard disks become unfit to record data. When data Errors are being 
recorded to the disk and there is a bad sector, the disk may not be able to correctly record 
the data, and a disk write error is generated. VitalView detects this type of hardware error. 

The first time VitalView detects a disk write error, it will close the data file to which it was 
writing when the error occurred, and start a new data file. This is likely to clear the error, 
since a different portion of the hard disk will be used. However, VitalView will only do this 
one time. Any subsequent disk write error will be indicated by the yellow “Yes” in the Data 
Collection Monitor display. Similar to the power failure indicator, it may be cleared by exiting 
the Data Collection Monitor, and re-entering it from the Main window. If the disk write 
error indicator is still “Yes” when the Data Collection Monitor is re-entered, it means the 
error is continuing and it is likely the data are no longer being written to the hard disk. It is 
recommended you stop data collection, exit VitalView, and run a hard disk evaluation utility 
such as ScanDisk. If the utility reports the disk is good following its test, restart VitalView 
and begin data collection (refer to Appendix G). 

Crash 
Recovery

Disk Write 
Errors
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Initialization Error Messages 
NOTE: The following error message may be ignored if you intend to collect data via Series 4000 devices 
only, and not via Series 3000 devices. 

Explanation 

There was an error generated when the VitalView program attempted to open the CB.CFG 
file. The CB.CFG file is the text file that is generated during the installation of the PCI 
interface card InstaCal driver software (see “PC Interface Card and Software Installation” 
Section 2). The CB.CFG file tells VitalView shortly after program launch what the PCI board 
number is. 

Possible causes 

1 File not found 
• CB.CFG file was inadvertently moved or deleted since VitalView installation, or

it was not installed because the “Install InstaCal Driver Software” step (item 1 of
“Install VitalView for PCI Interface Card” on the CD) was not run as part of the
VitalView installation process.

• Possibly the “Install InstaCal Driver Software” step was run, but neither C:\CB or D:\
CB was selected as the installation folder, as required for the VitalView program to
find the CB.CFG file.

2 File has become corrupted 
• CB.CFG file.

3 System error 
• File Input/Output
• Operating system
• Hard-disk drive hardware/firmware

Recommendation 

Exit VitalView, run VitalView one more time, and if initialization error number 1 comes up on 
this run also, exit VitalView, remove the VitalView installation with Add/Remove programs, 
and re-install VitalView (see “PC Interface Card and Software Installation” in Section 2). If 
this does not work to move VitalView past initialization error number 1, call Starr Life 
Sciences, and ask for VitalView technical support. If in fact all installation instructions were 
followed exactly, the likelihood is high there is a system error or PC fault preventing proper 
disk file read operation, or the CD installation process is corrupted or prevented by a 
system error (possibly a PCI board error) from occurring as it normally does on the vast 
majority of PCs. NOTE: An additional “capability not supported” error message may come on screen after “OK” is clicked 
from the initialization error number 1 message. In this case, ignore the additional error message, and 
click the “X” or close buttons until all VitalView windows disappear from the screen (and task bar). 

Initialization 
error number 
1
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Running ER-4000 Receivers - No PCI Interface Card 

Shortly after VitalView is launched, there will be the “Initialization error number 1” message. 
In this case of running ER-4000 receivers only (no Series 3000 devices or DP-24 data 
collection), ignore this error message, and click the OK button. Then configure VitalView for 
ER-4000 receivers and start data collection. 

Explanation 

The CB.CFG file was found, opened, and read successfully, but the CB.CFG file did not 
contain the expected “Board Type: PCI-DIO48H” text within the first 10,000 characters 
of the file, as is required. The CB.CFG file is the text file that is generated during the 
installation of the PCI interface card InstaCal driver software (see “PC Interface Card and 
Software Installation” in Section 2). The text “Board Type: PCI-DIO48H” and numeric text 
for the board number is appended to the CB.CFG file during step 3 of the Install VitalView 
for PCI Interface Card procedure (when the InstaCal driver software is run). Initialization 
error number 2 can only come on screen if VitalView has successfully made it past 
initialization error 1 (see above). 

Possible causes 

1 Step 3 of the Install VitalView for PCI Interface Card was not run, or did not complete 
its execution, or executed with an effect on the CB.CFG file inconsistent with what 
VitalView requires. 

2 File has become corrupted 
• CB.CFG file

3 System error 
• File Input/Output
• Operating system
• Hard-disk drive hardware/firmware

Recommendation 

Exit VitalView, run VitalView one more time, and if initialization error number 2 comes up on 
this run also, exit VitalView, remove the VitalView installation with Add/Remove programs, 
and re-install VitalView. See “PC Interface Card and Software Installation” in Section 2. Be 
sure to run all steps of the Install VitalView for PCI Interface Card, in the order specified on 
the CD installation program menu. If this does not work to move VitalView past 
initialization error number 2, call Starr Life Sciences and ask for VitalView technical support. 
If all installation instructions were followed exactly, the likelihood is high there is a system 
error or PC fault preventing proper disk file read operation, or the CD installation process 
is corrupted or prevented by a system error from occurring as it normally does on the vast 
majority of PCs. NOTE: An additional “capability not supported” error message may come on screen after “OK” is clicked 
from the initialization error number 2 message. In this case, ignore the additional error message, and 
click the “X” or close buttons until all VitalView windows disappear from the screen (and task bar). 

Initialization 
error number 
2
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Explanation 

The CB.CFG file was found, opened, and read successfully, and the CB.CFG file was found 
to contain the text “Board Type: PCI-DIO48H” within its first 10,000 characters. However, 
the CB.CFG file did not contain the expected “Board #” text within the first 15 characters 
behind the text “Board Type: PCI-DIO48H”, as is required. The CB.CFG file is the text file 
that is generated during the installation of the PCI interface card InstaCal driver software 
(see “PC Interface Card and Software Installation” in Section 2). The text “Board Type: PCI-
DIO48H” and numeric text for the board number is appended to the CB.CFG file during 
step 3 of the Install VitalView for PCI Interface Card procedure (when the InstaCal driver 
software is run). Initialization error number 3 can only come on screen if VitalView has 
successfully made it past initialization errors 1 and 2 (see above). 

Possible causes 

1 Step 3 of the Install VitalView for PCI Interface Card did not complete its execution, or 
executed with an effect on the CB.CFG file inconsistent with what VitalView requires. 

2 File has become corrupted 
• CB.CFG file).

3 System error 
• File Input/Output
• Operating system
• Hard-disk drive hardware / firmware

Recommendation 

Exit VitalView, run VitalView one more time, and if initialization error number 3 comes up on 
this run also, exit VitalView, remove the VitalView installation with Add/Remove programs, 
and re-install VitalView (see “PC Interface Card and Software Installation” in Section 2).  Be 
sure to run all steps of the Install VitalView for PCI Interface Card, in the order specified on 
the CD installation program menu. If this does not work to move VitalView past 
initialization error number 3, call Starr Life Sciences and ask for VitalView technical support. 
If all installation instructions were followed exactly, the likelihood is high there is a system 
error or PC fault preventing proper disk file read operation, or the CD installation process 
is corrupted or prevented by a system error from occurring as it normally does on the vast 
majority of PCs. NOTE: An additional “capability not supported” error message may come on screen after “OK” is clicked 
from the initialization error number 3 message. In this case, ignore the additional error message, and 
click the “X” or close buttons until all VitalView windows disappear from the screen (and task bar). 

Explanation 

The CB.CFG file was found, opened, and read successfully, and the CB.CFG file was found to 
contain the text “Board Type: PCI-DIO48H” within its first 10,000 characters, and also the 
text “Board #” within the first 15 characters behind the text “Board Type: PCI-DIO48H”. 
However, the numeric text in the CB.CFG file following the “Board #” text was found to be 
outside the range 0 to 255, or was unreadable as a valid numeric value. The CB.CFG file is 
the text file that is generated during the installation of the PCI interface card InstaCal driver 
software (see “PC Interface Card and Software Installation” in Section 2). The text “Board 
Type: PCI DIO48H” and numeric text for the board number is appended to the CB.CFG file 
during step 3 of the Install VitalView for PCI Interface Card procedure (when the InstaCal 

Initialization 
error number 
4

Initialization 
error number 
3
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driver software is run). Initialization error number 4 can only come on screen if VitalView 
has successfully made it past initialization errors 1, 2, and 3 (see above). 

Possible causes 

1 Step 3 of the Install VitalView for PCI Interface Card did not complete its execution, or 
executed with an effect on the CB.CFG file inconsistent with what VitalView requires. 

2 File has become corrupted 
• CB.CFG file

3 System error 
• File Input/Output
• Operating system
• Hard-disk drive hardware / firmware

Recommendation 

Exit VitalView, run VitalView one more time, and if initialization error number 4 comes up on 
this run also, exit VitalView, remove the VitalView installation with Add/Remove programs, 
and re-install VitalView (see “PC Interface Card and Software Installation” in Section 2).  Be 
sure to run all steps of the Install VitalView for PCI Interface Card, in the order specified on 
the CD installation program menu. If this does not work to move VitalView past 
initialization error number 4, call Starr Life Sciences and ask for VitalView technical support. 
If all installation instructions were followed exactly, the likelihood is high there is a system 
error or PC fault preventing proper disk file read operation, or the CD installation process 
is corrupted or prevented by a system error from occurring as it normally does on the vast 
majority of PCs. NOTE: An additional “capability not supported” error message may come on screen after “OK” is clicked 
from the initialization error number 4 message. In this case, ignore the additional error message, and 
click the “X” or close buttons until all VitalView windows disappear from the screen (and task bar). 
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